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iIntroduction
Welcome! This Step by Step book has been designed so you can read it from the 
beginning to learn about the infrastructure that supports the Microsoft Office for 
iPad apps, the common user interface elements, and the skills you can use when 
working in any of them; and then build your skills as you learn to perform increas-
ingly specialized procedures. Or, if you prefer, you can jump in wherever you need 
ready guidance for supporting the apps or performing tasks in Microsoft Word for 
iPad, Excel for iPad, PowerPoint for iPad, and OneNote for iPad. The how-to steps 
are delivered crisply and concisely—just the facts. You’ll also find informative, full-
color graphics that support the instructional content.

Who this book is for
Microsoft Office for iPad Step by Step is designed for use as a learning and reference 
resource by home and business users of Office programs who want to use Word, 
Excel, PowerPoint, and OneNote to create and edit documents, workbooks, presen-
tations, and notebooks on iPads. The content of the book is designed to be useful 
for people who have previously used Word, Excel, PowerPoint, and OneNote on 
other platforms and for people who are discovering Office apps for the first time.

The Step by Step approach
The book’s coverage is divided into parts representing general Office app skills or 
specific apps. Each part is divided into chapters representing skill set areas, and each 
chapter is divided into topics that group related skills. Each topic includes expository 
information followed by specific procedures. At the end of the chapter, you’ll find a 
series of practice tasks you can complete on your own. You can use the practice files 
that are available from this book’s website to work through the practice tasks, or you 
can use your own files.
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Download the practice files
Before you can complete the practice tasks in this book, you need to download the 
book’s practice files to your Microsoft OneDrive or OneDrive for Business storage 
drive from http://aka.ms/iPadOfficeSBS/files. Follow the instructions on the webpage.

IMPORTANT  The Office for iPad apps are not available from this website. You should 
install those apps before using this book.

You can open the files that are stored on your OneDrive from within the Office for 
iPad apps and save a duplicate copy of each file on your iPad. The apps automati-
cally save changes to the practice files. If you later want to repeat practice tasks, you 
can download the original practice files again.

SEE ALSO  For information about opening and saving files, see “Create, open, and save 
files” in Chapter 3, “Create and manage files.”

The following table lists the practice files for this book.

Chapter Folder File

1: Office for iPad basics iPadOfficeSBS\Ch01 None

2: Get connected iPadOfficeSBS\Ch02 None

3: Create and manage files iPadOfficeSBS\Ch03 NavigateOffice.docx 
OpenFiles.xlsx 
PrintSheets.xlsx 
PrintSlides.pptx 
SearchReplace.docx 
SearchScope.xlsx 
SendCopy.pptx 
SendLink.xlsx 
SendReview.docx

4: Create professional documents iPadOfficeSBS\Ch04 ArrangeText.docx 
FormatParagraphs.docx 
FormatText.docx 
PastePractice.docx 
StructureContent.docx
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Chapter Folder File

5: �Add visual elements to documents iPadOfficeSBS\Ch05 ArrangeImages.docx 
CreateLists.docx 
CreateTables.docx 
FormatPictures.docx 
FormatShapes.docx

6: Enhance document content iPadOfficeSBS\Ch06 ConfigurePages.docx 
CreateColumns.docx 
CreateTextBoxes.docx 
InsertReferences.docx 
ReviewContent.docx

7: Store and retrieve data iPadOfficeSBS\Ch07 DisplayData.xlsx 
EnterData.xlsx 
ManageCells.xlsx 
ManageStructure.xlsx 
ManageWorksheets.xlsx

8: �Process and present numeric data iPadOfficeSBS\Ch08 CreateCharts.xlsx 
CreateTables.xlsx 
PivotData.xlsx 
ProcessData.xlsx 
ReviewComments.xlsx

9: Create compelling presentations iPadOfficeSBS\Ch09 AddGraphics1.pptx 
AddGraphics2.docx 
AddText1.pptx 
AddText2.docx 
AddText3.xlsx 
ChangeSize.pptx 
ManageSlides.pptx

10: �Prepare and deliver slide shows iPadOfficeSBS\Ch10 AnimateTransitions.pptx 
EnterNotes.pptx 
ManageRecordings.pptx 
PresentShow.pptx

11: �Store information in digital 
notebooks

iPadOfficeSBS\Ch11 MoveNotes.one 
StoreNotes.one

12: �Locate and share notebook content iPadOfficeSBS\Ch12 ShareNotes.one

xiii
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Adapt exercise steps
This book contains many procedures for performing tasks in Word, Excel, 
PowerPoint, and OneNote on your iPad. The procedural instructions use this 
format:

1.	 To select the paragraph that you want to format in columns, triple-tap 
the paragraph.

2.	 On the Layout tab, tap Columns to display the scrollable menu of 
column layout options.

3.	 On the Columns menu, tap Three.

On subsequent instances of instructions that require you to follow the same 
process, the instructions might be simplified in this format because the 
working location has already been established:

1.	 Select the paragraph that you want to format in columns.

2.	 On the Columns menu, tap Three.

The instructions in this book assume that you’re interacting with on-screen 
elements on your iPad by tapping the screen (with your finger or a stylus) 
and interacting with on-screen elements on desktop computers by clicking 
(with a mouse, touchpad, or other hardware device). If you’re using a differ-
ent method—for example, if you have an external keyboard connected to 
your iPad or if you use a touchscreen computer—substitute the applicable 
tapping or clicking action when you interact with a user interface element. 
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Instructions in this book refer to iPad user interface elements that you tap 
on the iPad screen as icons, to Office app user interface elements that you 
tap on the iPad screen as buttons, and to physical buttons that you press 
on the iPad device as buttons, to conform to the standard terminology 
used in documentation for these products.

When the instructions tell you to enter information, you can do so by typing 
on a connected external keyboard, tapping an on-screen keyboard, or even 
speaking aloud, depending on your iPad or computer setup and your per-
sonal preferences.

Images in this book depict the iPad interface as it appears when the iPad 
is oriented horizontally. This maximizes the ribbon width in the Office for 
iPad apps so the buttons aren’t crowded. (And, as a bonus, the horizon-
tally oriented images require less vertical space on the page than vertical 
images, leaving more space available for words.) You can orient your iPad 
vertically or horizontally depending on your preference. For example, 
when the ribbon and on-screen keyboard are both open, you might want 
to work with your iPad oriented vertically to have more space available 
between those elements. When the iPad is oriented vertically, some ele-
ments of the Office app user interface might appear slightly different from 
those depicted in the book. For example, some buttons on the ribbon 
might be represented by icons instead of words.
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Ebook edition
If you're reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at 
http://aka.ms/iPadOfficeSBS/details.

Get support and give feedback
This topic provides information about getting help with this book and contacting us 
to provide feedback or report errors.

Errata and support
We’ve made every effort to ensure the accuracy of this book and its companion content. 
If you discover an error, please submit it to us at http://aka.ms/iPadOfficeSBS/errata. 

If you need to contact the Microsoft Press Support team, please send an email 
message to mspinput@microsoft.com.

For help with Microsoft software and hardware, go to http://support.microsoft.com.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress.

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at http://twitter.com/MicrosoftPress.
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7Store and 
retrieve data

In this chapter
■■ Create workbooks

■■ Create and manage worksheets

■■ Enter and edit data on 
worksheets

■■ Modify columns and rows

■■ Modify cells and cell content

■■ Manage the display of data

Practice files
For this chapter, use the practice 
files from the iPadOfficeSBS\Ch07 
folder. For practice file download 
instructions, see the Introduction.

Excel provides a practical yet powerful data manage-
ment framework. You can store massive quantities of 
data within this deceptively simple structure, analyze 
that data, and present the resulting information in a 
variety of structures. The key ingredient in all of these 
tasks is the original data. The final presentation or 
analysis is only as good as the data it’s based on. This 
“garbage in, garbage out” rule is true for many business 
tools, programs, and processes; Excel is no exception.

A worksheet can contain a vast amount of static and 
calculated data. You can structure worksheet content so 
that data is presented correctly on the screen and when 
printed, and you can format data so that it is easier for 
readers to locate and understand specific categories of 
information.

This chapter guides you through procedures related 
to creating workbooks and worksheets, managing 
worksheets and worksheet elements, populating work-
sheets with text or numeric data, modifying worksheet 
structure, and formatting data for presentation. It also 
includes procedures for efficiently displaying, filtering, 
and sorting data to provide specific information and 
perspectives.
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The Excel feature set
Excel for iPad has only a subset of the features of the full program. Here is 
a brief comparison of the features in each version. You can save and edit 
workbooks in a shared storage location by using multiple versions.

Excel for iPad features
After you sign in by using a Microsoft account, you can do the following:

■■ Create, manage, and print workbooks and worksheets.

■■ Format, find, replace, sort, and filter content.

■■ Insert pictures that are available on your iPad.

■■ Create formulas, Excel tables, and charts.

■■ Display conditional formatting and interact with data validation 
options, PivotTables, and comments.

The following premium features require that you sign in by using an account 
that is associated with a qualified Office 365 subscription:

■■ Insert and edit WordArt.

■■ Customize PivotTable styles and layouts.

■■ Add custom colors to shapes, and add shadows and reflection styles 
to pictures.

Excel Online features
You can use Excel Online to do the following:

■■ Coauthor workbooks in real time and edit macro-enabled workbooks.

■■ Display three-dimensional charts, slicers, Power Pivot tables and 
charts, and Power View sheets.

■■ Embed workbooks on webpages.

■■ Send and compile surveys.

For more information about Excel Online, visit technet.microsoft.com/en-us 
/library/excel-online-service-description.aspx.
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Excel desktop version features
The desktop versions of Excel have the most functionality. For example, you 
can use Excel 2013 on a computer running Windows to do the following:

■■ Display multiple views of worksheets, split windows, multiple windows, 
and very large workbooks.

■■ Display and edit workbooks from remote storage locations offline.

■■ Insert equations and symbols.

■■ Insert pictures from local and online sources.

■■ Create SmartArt diagrams, and capture screen images.

■■ Copy and paint formatting.

■■ Insert header and footer content.

■■ Configure page layout options.

■■ Use apps and web resources to enhance content.

■■ Apply conditional formatting and sparklines.

■■ Sort and filter data by using slicers and timelines.

■■ Create and edit three-dimensional charts.

■■ Define named ranges.

■■ Audit formulas and require manual calculation of formulas.

■■ Analyze data by using the Quick Analysis tool.

■■ Create data validation rules, consolidate data, and perform conditional 
analysis.

■■ Group, subtotal, and outline data.

■■ Create PivotTables, Power Pivot data models, and Power View sheets.

■■ Create, save, and run macros.

■■ Use Office proofing tools.

■■ Protect workbook elements.

■■ Track changes, insert comments, and respond to comments.
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Create workbooks
As with other Office files, you can create a blank Excel workbook or a workbook 
that contains content from a template. Excel templates focus more on purpose 
than on appearance; they provide structure and functionality for specific types of 
information.

The templates that are available from within Excel for iPad range from a simple to-do 
list to a complex financial report and include expense reports, sales reports, household 
budgets, marketing budgets, time sheets, invoices, loan calculators, and ledgers. Most 
of the templates include basic calculations; some include advanced calculations and 
visual representations of data. Even if these don’t meet your specific needs, they can 
serve as a good example of ways to collect, track, process, or present data.

Excel for iPad has 16 built-in templates, including the blank workbook

Only the templates that are installed with Excel for iPad are available from the New 
page. Other workbook templates are available for Excel Online, and hundreds are 
available from within the desktop versions of Excel. If you create a workbook based 
on one of these templates and save the workbook to a shared storage location, you 
can then open and edit the workbook on your iPad.
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You can access templates for Excel Online from your iPad by using Safari or another 
web browser to visit store.office.live.com/templates/templates-for-Excel.

Additional templates are available online

To create a blank Excel workbook

1.	 In the Backstage view, on the File bar, tap New.

2.	 On the New page, tap New Blank Workbook.

To create a workbook from a built-in template

1.	 In the Backstage view, on the File bar, tap New.

2.	 Locate and then tap the thumbnail of the workbook template you want to use.

TIP  The processes of creating workbooks from Excel and Excel Online templates for 
use in Excel for iPad are the same as those of creating documents from Word and 

Word Online templates for use in Word for iPad. For step-by-step instructions, see “Create 
documents from templates” in Chapter 4, “Create professional documents.” For general 
information about creating files in Excel for iPad and other Office apps, see “Create, open, 
and save files” in Chapter 3, “Create and manage files.”
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Create and manage worksheets
Workbooks provide structure for the storage of information, but you store the 
information on worksheets within the workbook. A worksheet provides a seemingly 
simple cellular structure that can store more than 17 billion data points.

TIP  The current worksheet size limitation is 16,384 columns by 1,048,576 rows (which 
won’t be a limitation for most Excel users). A single cell can contain up to 32,767 characters.

You don’t have to store all your data on one worksheet. You can organize informa-
tion on separate worksheets so that the content of each worksheet is easier to review 
and manage. You don’t even have to store all related data on the same worksheet—
you can easily reference data on other worksheets for purposes such as performing 
calculations or creating reports. You can also reference data in other workbooks, 
so it isn’t necessary to have a copy of a worksheet that you reference from multiple 
workbooks in each of those workbooks.

Scroll sideways to access worksheet tabs that don’t fit in the sheet tab area

SEE ALSO  For information about referencing other worksheets and workbooks, see 
“Perform data-processing operations” in Chapter 8, “Process and present numeric data.”

Add, rename, and remove worksheets
A new, blank Excel workbook contains one worksheet named Sheet1. You can add 
more worksheets to the workbook for the purpose of storing or displaying data, and 
give each worksheet a meaningful name. If you want to use an existing worksheet 
as a starting point for another, you can make a copy of the worksheet, rename the 
copy, and then modify the data on the copy. The data on the copy is not linked to 
the data on the original worksheet.

196

Chapter 7: Store and retrieve data



7

To select or display a worksheet

1.	 In the sheet tab area, tap the worksheet tab.

To add a worksheet to a workbook

1.	 In the sheet tab area, to the right of the existing worksheet tabs, tap the Insert 
Worksheet button, which is labeled with a plus sign (+).

To create a copy of a worksheet

1.	 Display the worksheet that you want to copy.

2.	 Tap the active worksheet tab to display the shortcut bar.

3.	 On the shortcut bar, tap Duplicate.

To rename a worksheet

1.	 Display the worksheet that you want to rename.

2.	 Double-tap the active worksheet tab to activate the worksheet name for 
editing and display the on-screen keyboard.

3.	 Enter the new worksheet name, and then do one of the following:

●● Tap anywhere on the worksheet.

●● On the on-screen keyboard, tap Done or tap the Keyboard key.

IMPORTANT  The Undo command does not reverse actions such as renaming, hiding, 
and deleting that you perform on worksheet tabs.

To delete a worksheet from a workbook

1.	 Display the worksheet that you want to delete.

2.	 Tap the active worksheet tab. Then on the shortcut bar, tap Delete.

TIP  You can display charts and other visual representations of data on worksheets 
with their supporting data, or you can move them onto their own worksheets. In some 

versions of Excel, you can export a chart from a worksheet to its own chart sheet. For more 
information, see “Display data in charts” in Chapter 8, “Process and present numeric data.”
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Move and hide worksheets
Many workbooks contain multiple worksheets. The data you store or display on 
individual worksheets might exist independently or interact with content on other 
worksheets. For example, you might:

■■ Store data for individual time periods or projects on separate worksheets.

■■ Store static information such as resources, list options, and holiday dates on 
one worksheet and reference that information in calculations on several other 
worksheets.

■■ Display a chart on a worksheet that is separate from the data that supports it.

■■ Display data from multiple worksheets on a summary worksheet.

You can organize worksheets in a workbook by reordering them.

If you don’t need to have the information on a worksheet immediately available, or 
if you want to protect or conceal a worksheet, you can hide it. Hiding a worksheet 
removes the worksheet tab from the sheet tab area on the status bar but doesn’t 
remove any data.

To move a worksheet within a workbook

1.	 Display the worksheet that you want to move.

2.	 In the sheet tab area, tap and hold the active worksheet tab, and then drag it 
to its new location.

To hide a worksheet

1.	 Display the worksheet that you want to hide.

2.	 In the sheet tab area, tap the active worksheet tab. Then on the shortcut bar, 
tap Hide.

To unhide a worksheet

1.	 Tap the active worksheet tab.

2.	 On the shortcut bar, tap Unhide to display a list of the hidden worksheets in 
the workbook.

3.	 In the list, tap the name of the worksheet that you want to unhide.
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Show and hide worksheet elements
Data stored in an Excel worksheet is organized in columns and rows. The junction of 
each column and row is a cell, and this is where you enter data.

An empty worksheet resembles a piece of graph paper, with each cell outlined so 
you can easily locate it. Lettered headings across the top of the worksheet identify 
specific columns, and numbered headings down the left side of the worksheet iden-
tify specific rows. Worksheet tabs at the bottom of the window identify worksheets 
within the workbook.

You can hide all these user interface elements to display more of a worksheet or 
to focus on the worksheet content. You can also hide the Formula Bar when it isn’t 
required, so that it appears only temporarily while you edit cell content.

A summary sheet displays information based on the data on other worksheets

Hiding the Formula Bar or worksheet tabs affects all the worksheets in a work-
book. Hiding the gridlines or headings affects only the active worksheet. Excel 
preserves the gridline and heading settings, so if you exit and reopen a workbook 
the gridlines and headings on each worksheet will be as you left them.
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To hide Excel user interface elements

1.	 On the View tab, tap the Formula Bar, Gridlines, Headings, or Sheet Tabs 
slider to change its background to white.

To temporarily display the Formula Bar

1.	 Double-tap a worksheet cell to activate it for editing.

To permanently redisplay Excel user interface elements

1.	 On the View tab, tap the Formula Bar, Gridlines, Headings, or Sheet Tabs 
slider to change its background to green.

TIP  Exiting and reopening a workbook redisplays the Formula Bar and worksheet tabs 
if they’ve been hidden.

Enter and edit data on worksheets
Excel for iPad has a Ready mode and an Edit mode. When you’re working with the 
structural aspects of cells, Excel is in Ready mode and the active cell or cell range has 
selection handles. When you’re working with cell content, Excel is in Edit mode and 
there are no selection handles.

When you enter Edit mode, the Formula Bar opens above the worksheet, and the 
on-screen keyboard opens below the worksheet. This compresses the workspace sig-
nificantly. You can orient your iPad horizontally to display more columns or vertically 
to display more rows.

TIP  If your iPad is connected to an external keyboard, the on-screen keyboard doesn’t 
open in Edit mode. You can perform many operations by using keyboard shortcuts on 

an external keyboard. For a complete list of keyboard shortcuts, see the Appendix, “Touch-
screen and keyboard shortcuts.”

When Excel is in Edit mode, you can select individual cells, columns, or rows, but you 
can’t expand the selection directly on the iPad. (You can do so from a connected 
external keyboard.) Selecting a column or row activates the first cell in the column or 
row for editing.

200

Chapter 7: Store and retrieve data



7

Select cells, columns, and rows
A key step in the process of entering, modifying, or formatting worksheet 
content is selecting the cell or cells you want to work with. You can use these 
selection methods in the Excel for iPad touch interface:

■■ To select a cell, tap it once.

TIP  Selecting a cell or range of cells displays selection handles in the 
upper-left and lower-right corners of the selection and a related sta-
tistic on the status bar. For more information, see the sidebar “Quickly 
display statistics” in Chapter 8, “Process and present numeric data.”

■■ To select a range of cells, select the upper-left cell in the range, and 
then drag the lower-right handle to the lower-right cell of the range 
or flick the handle down or to the right to select all populated cells in 
that direction (from the current cell to the next blank cell).

■■ To select a column, tap the column heading (the colored block above 
the worksheet that is labeled with a letter). Selecting a column dis-
plays selection handles on the left and right sides of the column and 
the content of the first visible cell of the column in the Formula Bar.

■■ To select a row, tap the row heading (the colored block to the left of 
the worksheet that is labeled with a number). Selecting a row displays 
selection handles on the top and bottom of the row and the content 
of the first visible cell of the row in the Formula Bar.

TIP  Selecting a column or row displays a shortcut bar of relevant 
commands. To close the shortcut bar and maintain the selection, tap 
an empty area of the ribbon.

■■ To select multiple columns or rows, select one column or row and 
then drag the handles to select adjacent columns or rows. 

TIP  When an Excel table is active, tapping the column or row head-
ing might select only the corresponding column or row of the table.

■■ To select an entire worksheet, tap the Select All button, which is 
located at the junction of the column headings and row headings and 
is labeled with a triangle that points toward the worksheet.
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When you enter Edit mode from a cell that already contains content, or switch to 
a cell that contains content while you’re in Edit mode, Excel displays and selects the 
cell content in the Formula Bar.

The content of the active cell shifts to the far left when Excel is in Edit mode

TIP  It’s easy to forget that you’re in Edit mode. If you can’t select cells, columns, or 
rows in the worksheet, check the Formula Bar for the telltale Cancel and Finish buttons.

In Excel for iPad, you enter and edit all text in the Formula Bar. The cell immediately 
displays the text, but the cursor is never active in the cell as it is in the desktop ver-
sions of Excel. In addition to the standard letters and numbers, you can enter the 
special characters that are available from the standard, number, and function online 
keyboards. Most notably, you can insert a line break within text to manually wrap 
cell content in a specific location.

If the data you want to enter follows a specific pattern such as 5, 10, 15, 20 or 
Monday, Tuesday, Wednesday, Thursday, you can establish the pattern and then 
have Excel continue the pattern and fill in the rest of the cells for you.

If the data you want to store in a worksheet already exists in another location, you 
can copy it from the source and paste it into the worksheet. This avoids the errors 
that can occur when entering data manually. The process of pasting content in Excel 
is the same as in other Office for iPad apps. If you paste a table into a worksheet, the 
table cells will map to the worksheet cells so that the table retains its structure.

TIP  You can locate information within a workbook by searching for values, formula 
elements, or named objects. For information about searching Excel workbooks, see 

“Search file content” in Chapter 3, “Create and manage files.”
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Display and hide the shortcut bar
Regardless of your experience with Excel, it can take some practice to master 
the techniques for selecting and manipulating content by touch on an iPad 
rather than by using a mouse. When you are working with content in Excel 
for iPad, the shortcut bar can be very convenient because it provides access 
to the most frequently used commands for a selected entity. It can also be 
inconvenient because sometimes it opens on top of content or tools that 
you want to work with. 

Tapping a cell and then tapping it again displays the shortcut bar for the 
cell. (This action of tapping twice isn’t the same as double-tapping; it’s 
slower and has a different result.) Tapping a column or row heading once 
selects the column or row and also displays the shortcut bar.

You can perform most common tasks from the context-specific shortcut bar

You can hide the shortcut bar and still maintain the selection by tapping a 
colored part of the ribbon.

IMPORTANT  You perform many tasks in Word for iPad, Excel for iPad, and Power-
Point for iPad by using the same processes. Common processes include those for giving 

commands in the Office user interface and for opening, saving, searching, and distributing 
files. For more information, see Chapter 3, “Create and manage files.”
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To switch from Ready mode to Edit mode

1.	 Do any of the following:

●● Double-tap a cell.

●● Select a cell and then tap the Formula Bar.

●● Begin typing on a connected external keyboard.

●● Press Ctrl+2 on a connected external keyboard.

To switch from Edit mode to Ready mode

1.	 Do any of the following:

●● To complete the edit and move to the next cell, tap the Return key on 
the on-screen keyboard or press the Enter key on a connected external 
keyboard.

●● To complete the edit and stay in the current cell, tap the Finish button 
(labeled with a check mark) at the right end of the Formula Bar or the 
Keyboard key on the on-screen keyboard.

●● To complete the edit and expand the selection, hold down the Shift key 
and press an arrow key.

●● To discard the edit, tap the Cancel button (labeled with an X) at the right 
end of the Formula Bar.

To enter or edit cell content

1.	 Switch to Edit mode, and then enter text from the on-screen keyboard.

Or

From Ready mode or Edit mode, enter text from a connected external 
keyboard.

To insert a line break in cell content

1.	 In Edit mode, position the cursor where you want the line break.

2.	 In the upper-right corner of the on-screen keyboard, tap the Function button 
(labeled 123) to display the function keyboard.

SEE ALSO  For more information about the function keyboard, see “Perform 
data-processing operations” in Chapter 8, “Process and present numeric data.”

204

Chapter 7: Store and retrieve data



7

3.	 On the function keyboard, press and hold the Return key (labeled with a 
curved arrow) to display the Line Break key, and then slide your finger to the 
Line Break key.

TIP  The Line Break key and other hidden keys are visible only until you lift your 
finger from the screen. For more information about hidden keys, see “Perform 

data-processing operations” in Chapter 8, “Process and present numeric data.”

To move the content of one or more cells

1.	 Select the cell or cells.

2.	 Tap and hold the selection until an animated dotted line outlines the selection. 
Then without lifting your finger, drag the selected content to the new location.

To fill cells with data that matches a pattern

1.	 In Edit mode, enter the first two items of the data series into adjacent cells.

2.	 Switch to Ready mode.

3.	 Tap the first cell and then drag the selection handle to select the second cell.

4.	 Tap the selection to display the shortcut bar.

5.	 On the shortcut bar, tap Fill. Note the arrows that appear on the right and 
bottom sides of the selected cell.

6.	 Drag the right-pointing arrow to the right to fill the series over, or drag the 
downward-pointing arrow down to fill the series down.

TIP  You can automatically fill series containing days of the week, months of the year, 
numbers, text, dates, times, and more.

To delete cell content

1.	 Select the range of cells you want to clear.

2.	 On the shortcut bar, tap Clear.

Or

On the on-screen keyboard or a connected external keyboard, tap or press the 
Delete key.
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Modify columns and rows
A new worksheet has columns of equal width and rows of equal height. A standard 
letter-size printed page displays approximately 9 columns and 47 rows at the default 
sizes. The number of columns and rows visible on screen varies based on the dimen-
sions and resolution of your screen. The content that you enter in a worksheet will 
rarely fit perfectly in the default structure, especially if you’re entering text content.

You can vary the size and visibility of columns and rows to suit your data

Resize columns and rows
After you enter data in a worksheet, you can easily modify the structure of the 
worksheet to fit the content. You can change the size of columns and rows so their 
content is visible on screen and when printed. You can change the width of a column 
or height of a row manually or by using the AutoFit feature to size the column or 
row to fit its contents.

TIP  You can’t display or set the specific column width or row height measurements in 
Excel for iPad; you can adjust them only by dragging or by using the AutoFit feature.

To fit a column or row to its contents

1.	 Double-tap the column or row heading.

Or

Select the column or row, and then tap AutoFit on the shortcut bar.

To change the width of a column

1.	 Select the column. Notice the handle that appears on the right side of the 
column heading.

2.	 Drag the handle to the left to make the column narrower or to the right to 
make the column wider.

206

Chapter 7: Store and retrieve data



7

To change the height of a row

1.	 Select the row. Notice the handle that appears below the row heading.

2.	 Drag the handle upward to make the row shorter or downward to make the 
row taller.

Insert and delete columns and rows
After you populate a data range or table, you can easily insert additional columns or 
rows into the range or table without overwriting existing data; existing columns shift 
to the right and rows shift down. Excel automatically updates any references in the 
workbook to the cells that shift to accommodate the insertion.

SEE ALSO  For information about referencing cells and cell ranges, see “Perform 
data-processing operations” in Chapter 8, “Process and present numeric data.”

You can specify the insertion location for columns or rows, or the columns or rows 
you want to delete, by selecting them, or by selecting only representative cells.

If a column or row containing the data you want to insert already exists, you can 
move that column or row to a different location or copy it to another location. When 
you delete columns or rows, Excel shifts the remaining content to fill the gap and 
updates any cell references in the workbook to reflect the change.

TIP  Note the difference between deleting and clearing cells. When you delete a cell, it 
is completely removed from the worksheet, and other cells move to replace it. When 

you clear a cell, the content of the cell is deleted, but the cell structure remains in place.

To insert a blank column

1.	 Select the column, or any cell in the column, that is in the position where you 
want to insert the blank column.

TIP  If you want to insert multiple columns in one location, drag the selection 
handle to the right to select the number of columns you want to insert.

2.	 On the shortcut bar, tap Insert Left.

Or

On the Home tab, tap the Insert & Delete Cells button, and then tap Insert 
Sheet Columns.
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To move or copy a column to another location

1.	 Select the column you want to move or copy.

TIP  If you want to move or copy multiple contiguous columns, drag the 
selection handles to select the adjacent columns.

2.	 On the shortcut bar, do one of the following:

●● If you want to move the selected column, tap Cut.

●● If you want to duplicate the selected column, tap Copy.

3.	 Select the column that is in the position where you want to place the column.

4.	 On the shortcut bar, tap Insert Left.

Or

On the Home tab, tap the Insert & Delete Cells button, and then tap Insert 
Sheet Columns.

To insert a blank row

1.	 Select the row, or any cell in the row, that is in the position where you want to 
insert the blank row.

TIP  If you want to insert multiple rows in the same location, drag the selection 
handle down to select the same number of rows that you want to insert.

2.	 On the shortcut bar, tap Insert Above.

Or

On the Home tab, tap the Insert & Delete Cells button, and then tap Insert 
Sheet Rows.
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To move or copy a row to another location

1.	 Select the row you want to move or copy.

TIP  If you want to move or copy multiple contiguous rows, drag the selection 
handles to select the adjacent rows.

2.	 On the shortcut bar, do one of the following:

●● If you want to move the selected row, tap Cut.

●● If you want to duplicate the selected row, tap Copy.

3.	 Select the row that is in the position where you want to place the cut or 
copied rows.

4.	 On the shortcut bar, tap Insert Above.

Or

On the Home tab, tap the Insert & Delete Cells button, and then tap Insert 
Sheet Rows.

To delete a column

1.	 Select the column, or any cell in the column, that you want to delete.

TIP  If you want to delete multiple contiguous columns, drag the selection 
handles to select the adjacent columns or cells.

2.	 On the Home tab, tap the Insert & Delete Cells button, and then tap Delete 
Sheet Columns.

To delete a row

1.	 Select the row, or any cell in the row, that you want to delete.

TIP  If you want to delete multiple contiguous rows, drag the selection handles 
to select the adjacent rows or cells.

2.	 On the Home tab, tap the Insert & Delete Cells button, and then tap Delete 
Sheet Rows.
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Hide and unhide columns and rows
If a data range includes a column or row of information that you either don’t want to 
display or don’t want to include in a chart, but that you don’t want to delete, you can 
hide it instead. The headings of a hidden column or row don’t change, so you can 
identify locations of hidden columns and rows by the missing headings and the thick 
lines that replace them.

IMPORTANT  You can’t hide columns or rows of Excel tables when you are working 
with a workbook in Excel for iPad. If you need to hide a table column or row, you can 

convert the table to a data range, hide the column or row, and then convert the data range to 
a table. For more information about Excel tables, see “Create and manage Excel tables” in 
Chapter 8, “Process and present numeric data.”

To hide a column or row

1.	 Tap the heading of the column or row you want to hide.

TIP  If you want to hide multiple contiguous columns or rows, drag the 
selection handles to select the adjacent columns or rows.

2.	 On the shortcut bar, tap Hide.

To unhide a hidden column or row

1.	 Tap the column heading to the left of the hidden column, then drag the right 
selection handle to the right to select the next visible column.

Or

Tap the row heading above the hidden row, then drag the lower selection 
handle down to select the next visible row.

2.	 On the shortcut bar, tap Unhide.

Modify cells and cell content
Sometimes you need to modify the structure of a worksheet on the cell level rather 
than modifying an entire column or row. For example, you might need to remove 
only one entry from a column that contains a list of entries. Deleting (clearing) the 
cell content would leave a gap—you must delete the entire cell to close the gap.
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Insert and delete cells
When you insert or delete individual cells from a worksheet, you must stipulate the 
direction in which Excel should shift the worksheet content that is below and to 
the right of the cell.

You choose the direction to shift content when inserting or deleting cells

To insert a blank cell in a populated range

1.	 Select the cell that is located where you want the blank cell.

2.	 On the Home tab, tap the Insert & Delete Cells button, and then tap Shift 
Cells Down or Shift Cells Right, depending on where you want to move the 
adjacent cells.

To insert multiple cells

1.	 Select the range of cells that occupy the space in which you want to insert the 
new blank cells.

2.	 On the Home tab, tap the Insert & Delete Cells button, and then tap Shift Cells 
Down or Shift Cells Right, depending on where you want the surrounding 
cells to be moved.

To delete a cell

1.	 Select the cell (or range of cells) that you want to delete.

2.	 On the Home tab, tap the Insert & Delete Cells button, and then tap Shift 
Cells Left or Shift Cells Up, depending on where you want the surrounding 
cells to be moved.
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Modify cell structure
By default, text content that exceeds the width of its column extends across adjacent 
columns if they are empty. If the adjacent column contains content, only the text 
that fits in the first column is visible. If you don’t want to resize the column to fit the 
text, you can wrap the text to display it on multiple lines.

TIP  In Excel for iPad, you can wrap the content of a single cell or multiple cells, but not 
of an entire column.

If a number is too wide to be displayed in a column, Excel displays the result in 
scientific notation, or displays number signs (#) instead of the number. You can’t 
wrap a long number, but you can widen the column or change the font size to fit the 
number in the cell.

Methods of handling content that exceeds the width of the cell

Sometimes it is appropriate to merge the content of multiple cells into one cell; for 
example, to indicate that a heading or label applies to multiple columns or rows. A 
merged cell occupies the space of the original cells.

IMPORTANT  When you merge multiple cells, Excel keeps only the data from the 
upper-left cell, and discards the other values. If the other cells contain data that you 

want to keep, move the data before merging the cells. 
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You can merge cells vertically, horizontally, or both

TIP  Merged cells can interfere with some types of operations on the surrounding 
columns or rows, such as filling cell data. If this happens, you can unmerge the cells, 

perform the operation, and then remerge the cells.

To wrap or unwrap text

1.	 Select the cell you want to format, and then tap the selected cell.

Or

Select multiple contiguous cells that you want to format.

2.	 On the shortcut bar, tap Wrap or Unwrap.

To merge a range of cells

1.	 Select the cells you want to combine.

2.	 On the Home tab, tap the Merge & Center button.

Format cell appearance
You can format worksheet content to help people identify key information. Beyond 
the standard font formatting options, you can add shading (also called fill color) 
and borders to cells. You can fill cells and apply borders independently or as part of 
a preset cell style. Some of the cell styles available in Excel are intended to convey 
specific information and others are linked to the workbook theme.

TIP  Conditional formatting is an incredibly useful tool for exposing trends in numeric 
data. You can’t apply or modify conditional formatting rules in Excel for iPad, but you 

can open worksheets that include conditional formatting rules created in other versions of 
Excel, and the rules function correctly in Excel for iPad.
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All the cell styles are purely decorative. None of the styles that are designated as 
titles and headings actually affect the structure of the content or link to an outline 
level, as headings in a Word document do.

You can use cell styles to add visual interest and meaning to a cell

SEE ALSO  For information about changing the font, size, color, and style of text, see 
“Change the appearance of text” in Chapter 4, “Create professional documents.”

A workbook can store many types of numeric data, and not all of these numbers 
should be displayed or processed in the same way. You can format specific types of 
numbers to display correctly and so that Excel correctly recognizes whether to process 
the number as a value or as something else (such as a date).

Excel for iPad includes 11 categories of number formats: 

■■ General  This is the default format for numbers. It permits Excel to process 
numbers in mathematic operations and to display numbers by using scientific 
notation if necessary to fit within the cell.

■■ Text  This number format instructs Excel to display and process the number 
exactly as you enter it. It is particularly useful for numbers with leading zeros 
and long numbers, such as credit card numbers, that Excel would otherwise 
change to scientific notation.
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■■ Accounting  This format allows you to display a specific number of decimal 
places and a currency symbol, which is left-aligned in the cell so the values are 
easier to read.

■■ Currency  This format allows you to display a specific number of decimal places 
and a currency symbol, which is flush against the numbers. You can also specify 
the format of negative values.

■■ Date  This format allows you to choose from among many standard options 
for displaying short and long dates to regional standards.

■■ Fractions  This format expresses a decimal number as the equivalent fraction. 
You can specify the denominator or degree of precision up to 1/999.

■■ Number  This format allows you to display a specific number of decimal places 
and specify whether to display the thousands separator and how to format 
negative numbers.

■■ Percentage  This format displays a decimal number as the equivalent per-
centage followed by the percent symbol. If you want to display more precise 
percentages, you can specify the number of decimal places.

■■ Scientific  This format expresses a number in scientific notation. You can 
specify the number of decimal places of the expression.

■■ Time  This format allows you to choose from among many standard options 
for displaying times or date/time combinations to regional standards.

■■ Special  This category includes region-specific formats for numbers such as 
ZIP codes, postal codes, phone numbers, and Social Security numbers.

To add, change, or remove cell borders

1.	 Select the cell or cell range for which you want to format borders.

2.	 On the Home tab, tap the Cell Borders button.

3.	 On the Cell Borders menu, do one of the following:

●● To apply a border to only one side of the selection, tap Bottom Border, 
Top Border, Left Border, or Right Border.

●● To apply borders to multiple sides of the selection, tap All Borders, Outside 
Borders, or Thick Box Border.

●● To remove all cell borders, tap No Border.
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TIP  Additional border styles and customization options are available in the desktop 
versions of Excel. If a worksheet cell has a border style that is unavailable in Excel for 

iPad, you can apply the border to other cells by copying the cell and then pasting only the 
format to the other cells.

To specify or remove a cell background color

1.	 Select the cell or cell range you want to format.

2.	 On the Home tab, tap the Fill Color button.

3.	 On the Fill Color menu, do one of the following:

●● Tap the color you want to apply.

●● Tap No Fill to remove any applied color.

TIP  The Fill Color dialog box displays six variations of each theme color, 10 standard 
colors, and a Custom Color link that displays a spectrum you can select a color from. 

To apply a preset cell style

1.	 Select the cell or cell range you want to format.

2.	 On the Home tab, tap the Cell Styles button.

3.	 On the Cell Styles menu, tap the style you want to apply.

To specify a number format

1.	 Select the cell or cell range you want to format.

2.	 On the Home tab, tap the Number Formatting button.

3.	 On the Number Formatting menu, do one of the following:

●● To apply the default format for a category, tap the category name.

●● To apply a specific number format, tap the i (the information symbol) to 
the right of the category name. Set the format-specific options, and then 
tap away from the menu to close it.

TIP  You can summarize large amounts of data for analysis by using a PivotTable, and 
present visual representations of data as charts. For more information about these 

presentation tools, see Chapter 8, “Process and present numeric data.”
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Manage the display of data
When a worksheet contains a large amount of data, it can be challenging to review 
the data, especially on a small screen such as that of the iPad. If you need to keep all 
the data at hand, you can rotate the iPad to display more columns or more rows at the 
same magnification; hide headings, worksheet tabs, and other user interface elements 
to increase the space available for the worksheet; or zoom out to display more content 
in the app window. You can freeze the column and row labels so they stay visible—and 
identify the on-screen content—while you flick through the data range.

If you’re focusing on specific data, you can hide columns and rows that you don’t 
need to review. To really narrow things down, you can hide data that isn’t relevant to 
your needs by filtering it, and then present different aspects of the data for evalua-
tions by changing the sort order.

SEE ALSO  For information about hiding user interface elements, columns, and rows, see 
“Create and manage worksheets” and “Modify columns and rows” earlier in this chapter.

Freeze panes
When a worksheet contains more data than you can display on one screen, you 
must scroll vertically or horizontally to display additional fields and entries. When 
you scroll a worksheet that contains a data range, the lettered column headings and 
numbered row headings can help you to identify the visible data, but it’s easy to 
lose track of specific fields or entries. To simplify this process, you can “freeze” the 
columns and rows that contain labels so they stay in place when you flick through a 
worksheet. 

For a typical data range that starts in the upper-left corner of a worksheet (cell A1), 
the top row contains the column labels and the first column contains the row labels. 
Because this is common, Excel provides options to freeze the top row and the first 
column. Alternatively, you can select the first cell that you want to scroll and then 
choose the option to freeze the worksheet panes above and to the left of that.

Frozen panes are indicated by thin lines on the worksheet that start between the 
column headings or row headings. When the display of gridlines is turned off, the 
lines are visible in the worksheet background.
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You can freeze panes at any location in a worksheet

To freeze the panes to the left of and above a specific cell

1.	 Position the worksheet so that the rows you want to have visible after you 
freeze the panes are the first rows in the window.

IMPORTANT  In Excel for iPad, freezing rows prevents the frozen rows from 
scrolling, so if you want to have multiple rows visible when scrolling, ensure 

that they are exposed before you freeze the rows.

2.	 Select the first cell that you want to scroll (this cell will not be frozen).

3.	 On the View tab, tap Freeze Panes. Then on the Freeze Panes menu, tap 
Freeze Panes.

To freeze the first visible column

1.	 Position the worksheet so that the one column you want to freeze as you scroll 
horizontally is the first column in the window.

2.	 On the View tab, tap Freeze Panes. Then on the Freeze Panes menu, tap 
Freeze First Column.

To freeze the first visible row

1.	 Position the worksheet so that the one row you want to freeze as you scroll 
vertically is the first row in the window.
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2.	 On the View tab, tap Freeze Panes. Then on the Freeze Panes menu, tap 
Freeze Top Row.

To unfreeze panes

1.	 On the View tab, tap Freeze Panes.

2.	 On the Freeze Panes menu, tap the current selection, and then tap a blank 
area of the ribbon to close the menu. 

Sort and filter data
A key feature of Excel is the ability to locate specific data or data that meets specific 
requirements. You can use the search function to locate specific text or characteris-
tics and then move among the results one by one. For many purposes, however, it’s 
more useful to manipulate the data range to display data in a certain arrangement 
or to display only (and all) the records that share specific characteristics. 

You can sort a data range or Excel table by the entries in any column to present the 
data in different ways. For example, if you have a list of products offered by different 
companies at different prices, you can sort the data by company name, by product 
name, or by price. Then you can narrow down the options by filtering the data to 
display only (and all) the records that share specific characteristics.

Filtering displays only the rows that contain the selected entry
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TIP  You can filter a data range by more than one column to display only entries that 
meet multiple criteria. In Excel for iPad, you can sort a data range by only one column 

at a time; you can’t perform multilevel sorts from the Sort & Filter menu.

Filtering is off by default for data ranges, but you can easily turn it on. When you do, 
Excel evaluates the data and displays a Sort & Filter button at the right edge of each 
data column heading. The button label changes to indicate the column status, as 
follows:

■■ When a column is neither sorted nor filtered, the button is labeled with a 
downward-pointing triangle.

■■ When data is sorted by a specific column, the button is labeled with an arrow 
that points up to indicate an ascending sort order from smallest to largest (or 
A to Z) or down to indicate a descending sort order from largest to smallest 
(or Z to A).

■■ When the data range is filtered by a specific column, the button is labeled 
with a funnel-shaped symbol that represents a filter.

Filtering a data range by one or more columns displays the entire entry (row) that 
matches the filter criteria specified for the columns.

To display the Sort & Filter buttons for a data range

1.	 Select any cell in the data range.

2.	 On the Home tab, tap the Sort & Filter button, and then tap the Filter slider 
to change its background to green.

TIP  It isn’t necessary to display the Sort & Filter buttons to sort data, but if you’re 
going to perform more than one sort it’s convenient to have them there.

To sort a data range by a specific column

1.	 In the heading of the column that contains the sort criteria, tap the Sort & 
Filter button, and then tap Ascending or Descending.

Or
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1.	 Select any cell in the column that contains the sort criteria.

2.	 On the Home tab, tap the Sort & Filter button.

3.	 On the Sort & Filter menu, tap Ascending or Descending.

To filter a data range by a specific column entry

1.	 Display the Sort & Filter buttons for the data range.

2.	 In the heading of the column that contains the filter criteria, tap the Sort & 
Filter button.

3.	 On the Sort & Filter menu, tap to select or clear the selection of values to be 
displayed.

TIP  A check mark indicates the filter values. Tap (Select All) to quickly select or 
clear the selection of all available values.

To clear a filter

1.	 In the heading of the column that contains the filter criteria, tap the Sort & 
Filter button.

2.	 On the Sort & Filter menu, tap Clear Filter.

Skills review
In this chapter, you learned how to:

■■ Create workbooks

■■ Create and manage worksheets

■■ Enter and edit data on worksheets

■■ Modify columns and rows

■■ Modify cells and cell content

■■ Manage the display of data
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Practice tasks
The practice files for these tasks are located in the iPadOfficeSBS\Ch07 
folder.

Create workbooks
Start Excel, and then perform the following tasks:

1.	 Create a blank workbook, and then save the workbook on your iPad as My 
Blank Workbook.

2.	 Create a new workbook based on the built-in Movie List template.

3.	 Starting in cell C9, add information about your three favorite children’s 
movies to the table. Notice that Excel continues the banded row striping 
automatically.

4.	 Save the workbook on your iPad as My Movie Workbook.

5.	 Create a new workbook based on any of the Excel Online templates.

6.	 After Excel saves the workbook to your OneDrive, open it in Excel for iPad and 
notice the file name.

7.	 Save a duplicate copy of the workbook on your iPad as My Online Workbook. 
Then navigate from the Open page of the Backstage view to the Documents 
folder on your OneDrive and open the workbook that has the name you iden-
tified in step 6.

8.	 Verify that the open workbook is the one you created from the Office Online 
website.

9.	 On the Open page of the Backstage view, tap the File Actions button next to 
the workbook name and then follow the process to delete the open workbook 
from your OneDrive.
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Create and manage worksheets
Open the ManageWorksheets workbook, and then perform the following tasks:

1.	 Review the information on the Month 1 worksheet.

2.	 Create a new worksheet after the Month 2 worksheet. Name the new 
worksheet Our Goals.

3.	 Insert two copies of the Month 1 worksheet as the last worksheets in the 
workbook. Name the worksheets Month 3 and Month 4.

4.	 Move the Our Goals worksheet to the right end of the sheet tab area, and 
then hide it.

5.	 On the Month 1 worksheet, hide the Formula Bar, gridlines, and headings. Then 
verify that the gridlines and headings are still visible on the other worksheets.

6.	 Redisplay the hidden worksheet, and then redisplay the Formula Bar.

Enter and edit data on worksheets
Open the EnterData workbook, and then perform the following tasks:

1.	 Review the information on the January worksheet. Then display the February 
worksheet.

2.	 In cell A9, add a new employee to the schedule by replacing Employee 5 with 
the name Jean.

3.	 Without leaving Edit mode, move to cell AG4 and insert a line break imme-
diately before the word Days. Then complete the edit and return to Ready 
mode.

4.	 Move the content of cells M7:N7 to Q7:R7 so there are only two people out of 
the office on February 13th.

5.	 Extend Kathy’s vacation for the rest of the week by filling the pattern from 
Q7:R7 through to cell U7.

6.	 On the March worksheet, update cell A9 to add Jean to the schedule. Schedule 
an offsite training for Jean on the first weekday of the month by entering a T 
in cell C9 and completing the edit.

7.	 Cancel two of Susie’s vacation days by deleting the content of cells Q5:R5.
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Modify columns and rows
Open the ManageStructure workbook, and then perform the following tasks:

1.	 Manually change the width of column B and the height of row 2 to more 
closely fit their content. Then use the AutoFit feature to make the column and 
row exactly the right sizes to fit their content.

2.	 Insert a new column to the left of column C. Enter Teacher in the column 
header.

3.	 Insert a copy of column E in columns F and G. Change the new column head-
ers to Quarter 3 and Quarter 4, and then delete the grades from the new 
columns without clearing the formatting.

4.	 Move the Teacher column so it is between the Period and Class columns.

5.	 Insert two new rows above row 5. Enter Lunch in B5 and Recess in B6.

6.	 Hide the Lunch row. Then unhide the Lunch row and hide the Recess row 
instead.

Modify cells and cell content
Open the ManageCells workbook, and then perform the following tasks:

1.	 Review the Team Jerseys worksheet. This worksheet contains a list of team 
members, the number that appears on the back of each player’s uniform shirt, 
and a space to indicate the person who picked up the shirt from the coach. 
The entries are split into two sets of columns.

2.	 Change the number format in columns B and F to display whole numbers 
(without any decimal places).

3.	 The numbers printed on the players’ shirts are all two digits. Apply a number 
format that won’t remove leading zeros. Then enter a 0 before each number 
from 1 through 9.

4.	 Select the three cells that contain information about Jane. Insert a set of three 
cells above Jane’s (without deleting Jane’s information), and then enter the 
name Jaime in the new Player Name cell.
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5.	 Cells E16:G17 contain two entries for the same girl, as evidenced by the match-
ing names and shirt numbers. Delete the three cells in row 16 that contain 
information for Presley K, and shift the cells upward to fill the gap.

6.	 In the second set of columns, create space for two new entries in rows 14 and 
15, below the entry for Mallory. Enter Marcella in row 14 and Mary in row 15.

7.	 Format cells C1 and G1 so that the column headings no longer wrap within the 
cells. Then use the AutoFit feature to size the columns to the minimum width 
required to fit the text.

8.	 Merge cells G10:G11, and enter Lola’s mom in the merged cell to indicate 
that she picked up both girls’ shirts. Then format the cell so its content is left-
aligned like those above and below it.

9.	 Select cells A1:G31, and add a thick border around the outside of the selection.

10.	 Apply a cell fill color that you like to cells A1:G1. Then remove the fill from cell 
D1 so only the headings are shaded.

Manage the display of data
Open the DisplayData workbook, and then perform the following tasks:

1.	 Freeze rows 1 and 2. Then flick down and up through the worksheet to confirm 
that the two rows remain visible.

2.	 Freeze column A. Then flick right and left through the worksheet to confirm 
that the column remains visible.

3.	 Unfreeze the frozen rows and column, and then move the worksheet up in the 
app window so that cell A10 is the first cell visible in the upper-left corner of 
the worksheet. Freeze the panes to the left of and above cell B13, and then 
move around the worksheet to see the effect.

4.	 Select any cell in the Daily Living data range, and then display the Sort & Filter 
buttons for that data range.

5.	 Sort the Home data in ascending alphabetical order.

6.	 Filter the Daily Living data range to display only data related to child care, 
dining out, and dog walking.
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11Store information 
in digital 
notebooks

In this chapter
■■ Create, open, and close 

notebooks

■■ Configure notebook storage 
structure

■■ Add information to notebooks

■■ Manage pages and sections

Practice files
For this chapter, use the practice 
files from the iPadOfficeSBS\Ch11 
folder. For practice file download 
instructions, see the Introduction.

OneNote is a very useful program that you can use to 
store many types of information and then access that 
information from any device. OneNote is equally useful 
for home and business purposes and is available for 
a wide variety of computer, tablet, and smartphone 
systems.

After you spend a short time using OneNote for iPad, 
you'll undoubtedly find it a convenient way to store 
many types of information, such as task lists, itineraries, 
frequent flyer accounts, supplier contact information, 
meeting notes, research findings, technical data, and 
printouts of contracts, receipts, and other documents 
you want to archive for future reference.

This chapter guides you through procedures related to 
creating and opening notebooks, adding sections to 
notebooks, adding pages to sections, adding content 
to pages, managing notebook content, and closing 
notebooks.
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The OneNote feature set
OneNote is available for use on many platforms, including Windows, 
Windows Phone, Mac, iPad, iPhone, Android, and Internet browsers. 
The Windows version of OneNote has significantly more features than 
any of the others.

Here is a brief comparison of the features you can use in the iPad, Office 
Online, and Windows versions of OneNote. More information about all 
the current versions is available at www.onenote.com.

OneNote for iPad features
When using OneNote for iPad, you can perform the following tasks:

■■ Create notebooks in cloud storage locations.

■■ Create, rename, and delete sections.

■■ Change the background colors of individual pages.

■■ Embed files, PDF printouts, local or photo stream images, Office Lens 
images, and links in notes.

■■ Format paragraphs and characters, and apply basic styles.

■■ Classify notes by applying predefined tags.

■■ Manage the password protection of notebook sections.

■■ Move and reorder sections, pages, and subpages.

OneNote for iPad doesn’t have any premium features that require an 
Office 365 subscription.

OneNote Online features
You can use OneNote Online to do the following:

■■ Move and resize note containers.

■■ Delete individual sections or entire notebooks.

■■ Locate edits made by other authors in a shared notebook.
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■■ Display content created or modified by specific authors.

■■ Change the color of a section, which affects the section tab and page 
navigator background.

■■ Play audio and video recordings that were embedded in notes by 
using a desktop version of OneNote.

For more information about OneNote Online, visit technet.microsoft.com 
/en-us/library/onenote-online-service-description.aspx.

OneNote for Windows features
The Windows version of OneNote has the most functionality. You can use 
OneNote 2013 on a computer running Windows to do the following:

■■ Change the color of a notebook, which affects the notebook cover.

■■ Change the display name of the notebook. This doesn’t change the 
name of the folder that contains the notebook content.

■■ Create and delete section groups.

■■ Create pages based on content-driven or artistic templates.

■■ Merge note containers, and select full notebook pages.

■■ Edit embedded files from within OneNote.

■■ Integrate tagged tasks with your Outlook task list, and send content 
from Outlook to OneNote.

■■ Record and embed audio and video recordings directly on a page, 
and coordinate the playback of recordings with your written notes.

■■ Capture and insert screen clips from within OneNote.

■■ Search notes by tag, by author, or by date, and search the content of 
audio recordings and the text in images.

■■ Generate a summary of tagged notes by storage location or date.

■■ Insert mathematical equations into notes.

■■ Draw or handwrite notes (by using your finger or a stylus).
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Create, open, and close notebooks
OneNote stores information in files that are referred to as notebooks. You can store 
all your information in one notebook or create multiple notebooks for different pur-
poses. For example, you could store general business information in one notebook, 
sensitive business information in a second notebook, and personal information in a 
third notebook.

In some versions of OneNote, you can create and work with notebooks that are 
stored locally on your computer or remotely in a connected storage location such 
as a OneDrive site or SharePoint site. In OneNote for iPad, you can work only with 
notebooks that are stored remotely.

Create notebooks
When creating a notebook in OneNote for iPad, you must create it on a OneDrive 
site or SharePoint site. A benefit of creating a notebook in one of these remote 
storage locations is that you can get to the information from any location or device. 
If you want to share some or all of the information in your notebook with other 
people, you can do that, too.

To create a notebook

1.	 Start OneNote and display the Backstage view.

2.	 On the File bar, tap Notebooks.

3.	 On the Notebooks page of the Backstage view, tap Create Notebook.

4.	 In the Create Notebook box, enter a name for the new notebook in the 
Name box.

5.	 If the Location box doesn’t display the storage location you want to use, tap 
the box. Then on the Location page that appears, tap the storage location 
you want.

6.	 In the Create Notebook box, tap the Create button to create and open a 
notebook that has the basic storage structure as a starting point.

SEE ALSO  For information about creating and configuring structural elements of a 
notebook, see “Configure notebook storage structure” later in this chapter. 
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OneNote gets you started
The first time you start OneNote for iPad, the app creates a notebook for you 
on the OneDrive site that is associated with your user account. This note-
book includes a built-in section named Quick Notes that contains a bit of 
information about how and why to use OneNote and some sample content.

You can retain the Quick Notes section for later reference

Some of the information in the Quick Notes section applies to versions of 
OneNote other than OneNote for iPad. You can add, remove, and update 
information in the Quick Notes section if you want to.

Open and switch among notebooks
The first time you open an existing notebook in OneNote for iPad, you must open 
it from its source location, which can be any storage location you’re connected to. 
When you open a notebook from a remote storage location, OneNote creates a 
copy on the device you're working on, and synchronizes the local copy with the 
server copy. Because of this feature, you can access information that is stored in a 
notebook even when you're offline, from any device on which you've previously 
opened the notebook.
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If you store or reference information in multiple notebooks, OneNote can maintain 
active connections to all of them when it’s running. You can display the content of 
only one notebook in the main app window at a time, but all the connected note-
books are “open” and synchronizing content, and you can easily switch among them. 
The currently open notebooks are shown on the Notebooks page of the Backstage 
view and the Notebooks menu in the OneNote app window.

Open or create notebooks from the Notebooks page of the Backstage view

To open an existing notebook for the first time

1.	 Start OneNote and display the Backstage view.

2.	 On the File bar, tap Open to display the storage locations you’re connected to.

3.	 If the storage location the notebook is stored in doesn’t already appear in your 
Places list, connect to it.

SEE ALSO  For information about connecting to storage locations, see “Connect 
to additional storage locations” in Chapter 2, “Get connected.”

4.	 Tap the storage location. If necessary, tap through the folder structure until 
you reach the notebook. Then tap the notebook.

5.	 If OneNote prompts you to enter user credentials, enter the account name and 
password for the account that has permission to access the notebook.
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To switch to a different open notebook

1.	 Start OneNote and display the Backstage view.

2.	 On the File bar, tap Notebooks.

3.	 In the list of open notebooks on the Notebooks page of the Backstage view, 
tap the notebook you want to display.

Or

1.	 With any notebook displayed in OneNote for iPad, tap the Notebooks 
button at the left end of the notebook header to display the currently 
open notebooks.

You can manage currently open notebooks from the Notebooks menu

2.	 On the Notebooks menu, tap the notebook you want to display.
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Close and reopen notebooks
It isn't necessary to close a notebook before exiting OneNote. It's simplest to leave 
all the notebooks that you use open all the time so that you can easily search their 
content. The notebooks will continue to synchronize in the background and you'll 
have access to current content when you need it. If you no longer need access to 
the information that is stored in a notebook—for example, if its content pertains 
only to a completed project—you can close it to keep the Notebooks menu and the 
Notebooks page of the Backstage view tidy.

After you close a notebook, it remains available to reopen from the Recent page of 
the Backstage view, or from its original storage location. If you want to ensure that 
you can quickly access a closed notebook at a later time, you can pin it to the Recent 
page and it will always be available from the Pinned section at the top of the page.

Pinned notebooks are convenient to access

To close a notebook

1.	 On the Notebooks page of the Backstage view, tap the File Actions button 
for the notebook you want to close.

2.	 On the Notebook Options menu, tap Close Notebook.

Or
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1.	 At the left end of the notebook header, tap the Notebooks button.

2.	 On the Notebooks menu, tap the File Actions button for the notebook you 
want to close.

3.	 On the notebook-specific menu, tap Close Notebook.

To reopen a notebook

1.	 On the Recent page of the Backstage view, tap the notebook you want to 
open.

SEE ALSO  For information about sharing notebooks and synchronizing notebook 
content, see “Protect and share information” and “Synchronize notebook content” in 

Chapter 12, “Locate and share notebook content.” 

Configure notebook storage structure
The notebook storage structure in OneNote reflects that of a physical tabbed 
notebook such as those used by students. You can divide notebooks into one or 
more sections. Each section contains one or more pages. You store information 
on individual pages.

A new notebook contains one section and one page. You can add sections and 
pages to provide a structure for the content you intend to store in the notebook.

The OneNote user interface elements
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As you add sections, you can name them in a way that is appropriate for the content. 
Be sure to give each section a meaningful name so you can easily identify it when 
you’re sending content to OneNote from another program.

TIP  In some versions of OneNote, you can optionally group sections into elements 
called section groups, which provide another layer of organizational structure. You can’t 

create section groups in OneNote for iPad, but you can navigate through section groups that 
already exist in notebooks created in other versions of OneNote. 

When you’re adding content to a notebook, you can create blank pages or pages 
that already contain content. If you have a clear idea of the kind of information you’re 
going to store in a notebook, you might find it simplest to build the notebook struc-
ture and then add content within that structure. But it isn’t necessary to build the 
structure first—if you prefer, you can send content to your notebook and then 
organize pages and sections by moving or copying them. Whatever works best for 
you will work with OneNote.

To create a section

1.	 In the notebook header, tap the New Section button.

To rename a section

1.	 In the notebook header, double-tap the tab of the section you want to 
rename.

Or

Tap the section tab, and then tap Rename to activate the title for editing.

The shortcut bar displays options for working with the selected title

2.	 Enter the new section name, and then tap the Done key on the on-screen 
keyboard.

TIP  If you’re working with an external keyboard connected to your iPad, you can press 
the Enter key to perform the action of the Done key in any procedure.
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To create a page

1.	 Display the section in which you want to create the page.

2.	 At the top of the page navigator, tap the Add Page button.

To change a page to a subpage

1.	 At the top of the page navigator, tap the Edit button.

2.	 Tap the selector to the left of the page name.

3.	 On the action bar at the top of the page navigator, tap the Demote button.

TIP  To change a subpage to a standard page, follow the same process but tap the 
Promote button.

To name or rename a page or subpage

1.	 In the page navigator, tap the page or subpage.

2.	 In the title area at the top of the page, replace the page title.

Add information to notebooks
You can use OneNote for iPad to create and gather notes in a variety of ways.

Enter and format text
To enter text on a page, you can tap the on-screen keyboard or type on an external 
keyboard. You can use the dictation functionality of the iPad to dictate notes ver-
bally, which can be a great time-saver after you become accustomed to the process. 
These processes are the same as those that you use to enter content in a document 
when using Word for iPad, so you're probably already familiar with them from the 
Word coverage earlier in this book.

SEE ALSO  For information about keyboard and dictation text-entry methods, 
including keyboard shortcuts and dictation commands, see “Enter text in documents” 

in Chapter 4, “Create professional documents.”
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If you want to keep track of the dates on which you enter specific notes, you can 
quickly insert the current date on your notebook page in mm/dd/yy format by tap-
ping the Date button on the Insert tab. You can reference information that exists 
on a website rather than recording separate notes about it by linking from a place-
holder on the notebook page to the webpage on the Internet.

SEE ALSO  For information about inserting hyperlinks to a webpage, see “Reference 
additional information” in Chapter 6, “Enhance document content.”

Formatting options for notebook page content include only the basics:

■■ You can apply a limited number of purpose-specific styles, including styles 
for a page title, six heading levels, normal paragraphs (the default), citations, 
quotes, and code. 

■■ You can format characters by applying bold, italic, underline, and strike
through font styles, changing the font color, and highlighting content.

■■ You can format paragraphs in these ways:

●● Change the paragraph indent in half-inch increments.

●● Create bulleted lists that use the default bullet characters.

●● Create numbered lists that use the default numbering formats.

The style and formatting options are available from the Home tab of the ribbon. You 
use the same methods to apply the available styles and formatting to page content 
in OneNote for iPad that you use in Word for iPad.

SEE ALSO  For more information, including step-by-step procedures for applying 
styles and formatting, see “Align, space, and indent paragraphs” and “Change the 

appearance of text” in Chapter 4, “Create professional documents,” and “Present content 
in lists” in Chapter 5, “Add visual elements to documents.”
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Work with notebook containers
When you enter information onto a notebook page, the information is stored inside 
a note container rather than directly on the page. A page can contain multiple note 
containers; tapping an empty area of the page that is not in or near an existing 
note container creates a new one.

Two note containers on a page

In OneNote for iPad, it's generally simplest to keep all your page content in one 
note container because you can't manipulate the containers as you can in OneNote 
for Windows. Double-tapping the header of a note container selects it and displays 
a shortcut bar of commands for manipulating the content.

Options for working with a selected note container

IMPORTANT  When you select a note container it might appear as though you 
actually selected the content. You can easily differentiate between the selection of a 

note container and its content: selecting only the content displays handles, whereas selecting 
the container does not.

In the Windows version of OneNote, you can move and merge note containers by 
dragging them on the page. This functionality is not currently available in OneNote 
for iPad; however, you can move a note container by moving its content.
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Like the other Office for iPad apps, OneNote automatically saves the changes you 
make to a notebook. You can undo all the changes you’ve made to a Word docu-
ment, Excel workbook, or PowerPoint presentation in the current app session by 
restoring the file to its most recently opened state. However, due to the way that 
OneNote stores information, you can’t restore OneNote notebooks. This can be 
both good and bad—you can enter notes and then exit the notebook without losing 
them, but you must take care when modifying content that you don't delete infor-
mation you might need later.

Organize notes in tables
Certain types of information that you store in a notebook will be easier to track if 
you organize it in tables. OneNote for iPad includes limited table functionality, but 
it does provide the option of inserting and then populating a table. The initial table 
created by OneNote for iPad when you insert a blank table is two columns wide by 
two columns high. You can insert additional rows or columns as necessary. OneNote 
for iPad doesn't include any special formatting options for tables.

To insert a blank 2-by-2 table

1.	 On the Insert tab, tap the Table button.

To add rows or columns to a table

1.	 To insert a single row or column, tap to position the cursor in a table cell 
adjacent to where you want to insert the row or column.

Or

To insert multiple rows or columns, select the number of existing rows or col-
umns you want to insert adjacent to where you want to insert the new rows or 
columns.

2.	 On the Table tool tab, tap the Insert button.

3.	 On the Insert menu, tap Rows Above, Rows Below, Columns Left, or Columns 
Right.
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To remove rows or columns from a table

1.	 To remove a single row or column, tap to position the cursor anywhere in that 
row or column.

Or

To remove multiple rows or columns, select cells in the rows or columns you 
want to remove.

2.	 On the Table tool tab, tap the Delete button.

3.	 On the Delete menu, tap Rows or Columns.

To delete a table

1.	 Tap to position the cursor anywhere in the table.

2.	 On the Table tool tab, tap the Delete button.

3.	 On the Delete menu, tap Table.

TIP  If you are working with an external keyboard connected to your iPad, you can 
create a table while inserting information. To do so, enter content and then press the 

Tab key to move to or create the next cell in the row, and the Return key in the last cell of the 
table to create a new row.

Insert images
One of the great things about OneNote is that you can store not only your own 
notes, but also many other types of information. Pictures, of course, are worth a 
million words—and when you're using OneNote for iPad, you have the advantage 
of working on a device that you can use to easily capture images at the same time 
you're taking notes.

You can insert photos that you’ve already taken with your iPad or another device 
and stored on your iPad or in your photo stream, or you can capture and insert 
photos from within OneNote. This simplifies the process of documenting something 
because you can intersperse pictures among your written notes as appropriate.
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Your iPad has its own camera app, but OneNote for iPad also comes with its own 
picture-management app, Office Lens. Office Lens has been specially engineered 
to enhance images of text, but you can use it to work with any photo.

A photo captured from within OneNote and displayed in Office Lens

When you capture images of whiteboards, printed documents, sticky notes, or other 
items that display text, Office Lens can enhance the image to make the text content 
easier to read. You can crop and straighten the image, and when you're happy with 
the result, Office Lens inserts the enhanced image into your notebook.

TIP  If you prefer to use the standard iPad camera app rather than Office Lens, you can 
turn off Office Lens from the iPad settings for OneNote.
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Office Lens crops, straightens, and sharpens text images

The Office Lens app is simple to use—it includes only four controls.

■■ The Back button returns to the active notebook page without inserting the 
photo.

■■ The Whiteboard, Photo, and Document modes analyze the photo and crop, 
straighten, and sharpen it to different standards.

■■ The Crop button displays handles that you can drag to designate the area of 
the photo you want to keep.

■■ The Finish button accepts the current settings and inserts the photo on the 
notebook page.
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To select or insert an existing photo from your iPad or photo stream

1.	 Tap to position the cursor where you want to insert the photo on the page.

2.	 On the Insert tab, tap the Pictures button.

3.	 On the Photos menu, tap the storage area that contains the photo you want 
to insert.

4.	 Locate the photo and tap it.

If you're using the default OneNote for iPad camera setting, the photo opens 
in Office Lens and you can enhance it before you insert it on the page. If you've 
turned off the option to use Office Lens, the photo appears on the page.

IMPORTANT  OneNote for iPad doesn’t include picture configuration options such as 
those that are available in Word and PowerPoint. You can reposition a photo by 

dragging it but you can’t specify the text wrapping or format the photo.

To capture a picture or text image from within OneNote

1.	 Tap to position the cursor where you want to insert the photo on the page.

2.	 On the Insert tab, tap the Camera button.

3.	 Position the iPad so the image you want to capture is in focus on the screen.

4.	 Tap the Capture button (the circle).

If you’re using the default OneNote for iPad camera setting, the photo opens 
in Office Lens; otherwise it appears on the page.

To enhance and insert a photo from Office Lens

1.	 If you want Office Lens to automatically enhance the image content, tap the 
Whiteboard and Document buttons to preview the results, and then tap 
the mode that best fits your needs.

2.	 If you want to crop or straighten the photo, tap the Crop button to display 
the original image with crop handles positioned where Office Lens senses that 
the image corners should be.

3.	 Drag the handles to define the area of the final image and its bottom edge, 
from which Office Lens calculates the alignment of the image.

4.	 Tap the Finish button to insert the photo.
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To turn off Office Lens

1.	 Start the Settings app.

2.	 Near the bottom of the Settings list, tap OneNote.

3.	 On the OneNote page, in the Photos & Camera section, tap Camera Setting.

4.	 On the Camera Setting page, tap the Use Office Lens slider to change its 
background to white.

Insert files from cloud storage locations
In OneNote for iPad, you can insert files from a cloud storage location into your 
notes. Different types of files create different results. For example:

■■ Inserting a Word document displays a labeled document icon on the page. 
You can display the file content and then open the file for editing.

■■ Inserting a graphic file displays the graphic on the page.

■■ Inserting a video file displays a labeled generic icon. You can play the video 
recording.

You can change the icon label from the file name to something more descriptive, 
but note that the labels wrap after approximately 13 characters.

IMPORTANT  At the time of this writing, OneNote for iPad supports inserting files 
only from iCloud and Dropbox storage locations.

You can search your cloud storage location for files that contain specific terms. To 
simplify the process of locating a file in your iCloud storage, you can sort the search 
results by Date, Name, or Tags.

The sorting options for search results 

357

Add information to notebooks



To insert a file from iCloud or Dropbox storage

1.	 Tap to position the cursor where you want to insert the file content on the 
page.

2.	 On the Insert tab, tap File.

A window displays your iCloud storage.

3.	 If you're inserting a file from iCloud, you can do the following:

●● To switch between the file thumbnail and file list views of your iCloud 
storage, tap the button that represents the view you want.

●● To search for a specific file, tap the Search box and enter the search 
parameter.

●● To change the sort order of files, tap Date, Name, or Tags.

4.	 If you want to insert a file from Dropbox, you can do the following:

●● To display your Dropbox storage, tap Locations in the upper-left corner of 
the window, and then tap Dropbox.

●● To search for a specific file in the Dropbox window, tap the Search box and 
enter the search parameter. 

5.	 Locate and then tap the file you want to insert.

 To change a file icon label

1.	 Tap the icon, and then on the shortcut bar, tap Rename.

2.	 In the Rename box, enter the label you want, and then tap Save.

To preview a file from an embedded icon

1.	 Double-tap the icon.

Or

Tap the icon, and then on the shortcut bar, tap Open.

2.	 Flick to scroll through the file.

3.	 To close the preview, tap Done in the upper-left corner of the window. 
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Send, print, and link content to notes
When you are using the Windows version of OneNote in conjunction with 
other programs in the Office suite, there are many additional ways you can 
store information in OneNote for safekeeping. For example, you can:

■■ Send email messages directly from Outlook to a OneNote notebook.

■■ Link tagged tasks in a notebook to your Outlook task list.

■■ Take meeting notes in personal or shared notebooks.

■■ Create notes that are linked directly to specific locations in a Word 
document or PowerPoint presentation.

■■ Print any Office file to a OneNote notebook.

Although you can’t perform these same actions in OneNote for iPad, you 
can work with the content of notebooks that are stored in shared locations 
in the iPad and Windows versions of OneNote.

To open a file for editing from a preview window

1.	 In the upper-right corner of the preview window, tap the File Actions button.

2.	 In the window that opens, tap the icon of the app you want to open the file in.

To manage cloud storage providers

1.	 On the Insert tab, tap the File button.

2.	 In the upper-left corner of the window, tap Locations. Then on the Locations 
menu, tap More.

3.	 In the Manage Storage Providers window, do either of the following:

●● To make your storage location with a cloud storage provider available, tap 
the provider's slider to change its background color to green.

●● To remove a cloud storage provider from the Locations menu, tap the 
provider's slider to change its background color to white.

4.	 In the upper-right corner of the Manage Storage Providers window, tap Done.
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Manage pages and sections
From time to time you might find it necessary to modify the storage structure of 
a notebook or move content around within the notebook. Fortunately, it's much 
easier to move information around in an electronic notebook than it is in a physical 
notebook.

You can rearrange notebook elements in the following ways:

■■ Move pages within a section, to another section in the same notebook, or to a 
section in any open notebook.

■■ Move sections within a notebook or to any other notebook that you have 
open. When you move a section to a different notebook, it is inserted as the 
last section in the notebook, and the section tab appears to the right of the 
other section tabs in the notebook header.

You can also assign background colors to notebook pages to provide a visual 
indicator of the purpose or status of a page—for example, a green background to 
indicate that the page content is final or an orange background to indicate that a 
page contains confidential information.

TIP  Changing the page background color in OneNote for iPad doesn’t affect the color 
of the page tab in the page navigator.

You control the movement of pages by activating the edit functions in the page 
navigator.

Tap Edit at the top of the page navigator to activate the edit functions
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After you finish organizing your notebook content, you might find that you have 
extra or empty notebook elements. You can delete any notebook element other 
than a section group and the notebook itself from within OneNote for iPad.

TIP  You can delete notebooks and section groups when working with a notebook in 
the Windows version of OneNote.

To change the color of the active page or subpage

1.	 On the View tab, tap the Page Color button.

2.	 On the Page Color menu, tap the color swatch you want to apply to the page.

Or

On the Page Color menu, tap the No color button to remove the page back-
ground color.

To move a page within a section

1.	 At the top of the page navigator, tap Edit.

2.	 In the page navigator, tap and hold the handle of the page you want to move, 
and then drag it vertically to the new location.

To move one or more pages to a different section or notebook

1.	 At the top of the page navigator, tap Edit.

2.	 In the page navigator, select the pages you want to move.

TIP  To select a page, tap the empty circle that precedes the page name. A 
check mark appears when the page is selected.

3.	 On the action bar at the top of the page navigator, tap the Move button to 
display a window showing the sections and section groups available in the  
current notebook.
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You might need to swipe the list to display all the sections and section groups in the notebook

4.	 To move the selected pages to a different section of the current notebook, tap 
the section you want to move them to.

Or

To move the pages to a different notebook, tap Notebooks to display a 
window showing the currently open notebooks; tap the notebook, the section 
group if appropriate, and then the section you want to move the pages to.

TIP  When you move a page to a different section, it is inserted as the last page in the 
section, at the bottom of the page navigator for that section. When you move a 

section to a different notebook, it is inserted as the last section in the notebook, to the right 
of the existing section tabs in the notebook header.
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To move a section within a notebook

1.	 In the notebook header, tap and hold the tab of the section you want to 
move, until the tab changes to a lighter color.

2.	 Drag the section tab laterally to the location you want it in relation to the 
other section tabs.

To move a section to a different notebook

1.	 Display the section you want to move.

2.	 Tap the section tab once.

3.	 On the shortcut bar, tap Move to display a window showing the currently 
open notebooks and any section groups they contain.

The section you're moving is identified above the notebook list

4.	 In the Notebooks window, tap the notebook you want to move the section to. 
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To delete a page

1.	 Display the section that contains the page you want to delete.

2.	 In the page navigator, swipe left or right on the tab of the page you want to 
delete, and then tap Delete.

IMPORTANT  OneNote stores your deleted pages in the Recycle Bin of the OneDrive 
site or SharePoint site the notebook is stored on. You can restore deleted pages from 

that Recycle Bin until they are permanently deleted (usually after 60 days).

To delete a section

1.	 Display the section you want to delete.

2.	 In the notebook header, tap the active section tab.

When you tap the tab once, the shortcut bar displays options relevant to the section

IMPORTANT  Tap a section tab once to display the shortcut bar, or twice to 
activate the section tab for editing.

3.	 On the shortcut bar, tap Delete.

364

Chapter 11: Store information in digital notebooks



11

Skills review
In this chapter, you learned how to:

■■ Create, open, and close notebooks

■■ Configure notebook storage structure

■■ Add information to notebooks

■■ Manage pages and sections
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Practice tasks
The practice files for these tasks are located in the iPadOfficeSBS\Ch11 
folder.

Create, open, and close notebooks and  
configure storage structure
Start OneNote, and then perform the following tasks:

1.	 Create a new notebook in your OneDrive storage location and name it 
My Notes.

2.	 Without closing your new notebook, open the StoreNotes notebook from the 
practice file folder.

3.	 Close the StoreNotes notebook, and then reopen it from the list of recent 
notebooks.

4.	 Switch to the My Notes notebook.

5.	 Rename the Welcome section as Practice One, and create a new section 
named Practice Two. Move the Practice Two section so it immediately follows 
the Practice One section.

6.	 In the Practice Two section, rename the untitled page as Page 1 and create a 
new page named Page 2.

7.	 Make Page 2 a subpage of Page 1, and rename it as Subpage One.

8.	 Exit OneNote without closing the open notebooks.

Add information to notebooks
Open the StoreNotes notebook if it isn’t already open, and then perform the  
following tasks:

1.	 In the Add Content section, on the Text Practice page, enter the following text 
just below the page title: Taking notes on the iPad is easy. Keep track of 
important information, and access it from anywhere.

2.	 Tap halfway down the page to create a second note container. In the new note 
container, insert a 2-by-2 table.
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3.	 In the first column of the table, enter January in the first row and February 
in the second row. In the second column, enter Garnet in the first row and 
Amethyst in the second row.

4.	 Add a third row to the end of the table. In the new row, enter March in the 
first column and Aquamarine in the second column.

5.	 Insert a row at the top of the table. In the new row, enter Month in the first 
column and Birthstone in the second column. Select the two cells, and then 
apply bold formatting to the words so they look like column headings.

6.	 Switch to the Image Practice page. From within OneNote, use your iPad and 
the Office Lens utility to capture an image of something (such as a notepad, 
whiteboard, or sticky note) that has handwritten text on it.

7.	 Enhance and crop the image by using Office Lens. Insert the modified image 
below the title of the Image Practice page.

8.	 Exit OneNote without closing the open notebooks.

Manage pages and sections
Open the StoreNotes notebook if it isn’t already open, and open the MoveNotes 
notebook. Then perform the following tasks:

1.	 Display the StoreNotes notebook.

2.	 In the My Pages section of the notebook, change the color of Page A to any 
shade of blue. Then change the color of Page B to any shade of green.

3.	 Move Page C above Page A.

4.	 Move Page A and Page B to the Practice Pages section of the notebook.

5.	 Move the Practice Pages section so that it precedes the My Pages section.

6.	 Move the Practice Pages section to the MoveNotes notebook. Then create 
a copy of the Practice Pages section in the StoreNotes notebook.

7.	 In the StoreNotes notebook, delete the My Pages section. Then in the  
Practice Pages section, delete Page B.

8.	 Exit OneNote without closing the open notebooks.
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Index
Symbols
#+= key  See on-screen keyboard
* (asterisk), in Excel formulas  237
+ (plus sign), in Excel formulas  237
- (minus sign), in Excel formulas  237
.?123 key  See on-screen keyboard
/ (forward slash), in Excel formulas  237
^ (caret), in Excel formulas  237
 (prohibition sign)  287

Numbers
123 button (Excel status bar)  See on-screen 

keyboard

A
Abc button  See on-screen keyboard
absolute references (Excel)  240, 243
accessibility options (iPad)

where to configure  15
zoom controls  61

Accounting number format (Excel)  215
accounts

associated online storage  27
connecting apps to  28, 33
Microsoft  10, 11, 38
Office 365  4
OneDrive  38

activating Office  28, 33
activating worksheet cells  202
AirPrint printers  72, 73
alignment

paragraphs  105
using tab stops  110

anchoring
images  137
shapes  146

animated transitions  See slide transitions
animation effects, on slides

applying  308
color, changing/choosing  309
emphasis effects  306

entrance effects  305, 307
exit effects  306, 307
multiple, applying  309
options, changing/choosing  309
order of  307
positioning  307
removing  310
selecting  309

annotating slides  331
App Store

installing apps  9
locating apps  8
updating apps  18

app support  xvi
apps

See also specific apps
automatic updates  9, 20
closing  44
deleting  22
displaying currently open  44
exiting  43, 44
grouping in folders  30
installing  4, 7, 9
locating  8
pane colors  60
passcodes, requiring  15
reinstalling  22, 23
removing from folders  30
removing from iPad  22
restricting access to  15
settings, configuring  16
signing in  33
starting  29, 31
switching between  45
updating  18–21
version history  20, 21
windows, and  60

area charts  250
arguments

See also functions; parameters; values
color coding  230
defined  246
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arranging images  153
artistic text effects  See WordArt effects
ascending order  220
aspect ratio

of charts  256
cropping images  139, 141, 142
shapes, and  146
slides, and  280

associating apps with an Office 365 
subscription  13

asterisk (*), in Excel formulas  237
attachments, opening from email  34
audio recordings

adding to slides  326
embedded, on slides  325
icons on slides  326
playback controls on slides  329
searching in notebooks  376
volume, controlling in presentations  325

author, displaying  66
automatic updates  9, 20
AutoSave  58, 64, 66
AutoSum formulas

functions  244
inserting  245

AVERAGE AutoSum function  244
Average function, in Total rows  229
axis titles  258

B
background color of cells  216
backing up content, to iCloud  35
backing up data, by using iTunes  5
Backstage view  63

commands on  63
displaying  63
starting apps from  50

backup settings  5
balloons

changes displayed in  178
comments displayed in  183

banded columns or rows  130
banner shapes  146
bar charts  250
basic shapes  146
blank files, creating  50

blank text boxes, creating  165, 166
blank workbooks, creating  195
block arrows  146
Bluetooth keyboards, connecting  83
bold, applying to text  115
bookmarking errors in dictation  95
borders

cells  213, 215
pages  87
tables  130

breaks  See column breaks; page breaks; section 
breaks

browsing content in OneDrive  34
built-in functions  242
built-in templates

PowerPoint  281, 282
workbooks, creating from  195

bulleted lists
creating as you type  124
demoting items  128
in documents  122–124
mixing with numbered lists  128
multilevel, creating  127–129
paragraphs, formatting as  123
promoting items  128, 129
symbols  123, 124
text, formatting as  123

C
calculations

See also formulas
in document tables  131
nested functions  248
order of processing  237, 238
parenthetical  238
refreshing manually  249

callout shapes  146
Camera Roll  299, 300
cameras

OneDrive as backup storage  37
settings for  13

capitalization, searching for  71
caret (̂ ), in Excel formulas  237
cell ranges  201

See also cells, in worksheets; data ranges
referencing, in formulas  231
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cell references
See also formulas
absolute  240, 243
changing  245
color-coding  238
creating  243
mixed  240, 243
options  240
relative  240, 241
syntax  239

cell selectors, color-coding  238
cell styles

preset, applying  216
in worksheets  214

cells, in tables  129, 135
cells, in worksheets  199

See also cell references
background color  216
borders  215
clearing content  205
comments, hiding/displaying  268
conditional formatting  213
deleting  211
editing content  204
entering content  204
equations, entering  242
fill patterns  205
formatting  213–216
formulas, copying  244
inserting  211
line breaks, inserting  204, 205
merged  212, 213
merging  213
moving content  205
selecting  201
shading  229
shifting direction of content  211
structure, modifying  212
styles  214
wrapping content within  202, 212, 213

centering paragraphs  105
changes  See tracked changes
changes to files, undoing  65, 67
character formatting

location of commands on ribbon  112
removing  116
Word for iPad, types of  112

characters
bullets  123, 127
displaying hidden  104
new line, inserting  293
tabs, inserting  111, 293

chart area  254  See also charts, in worksheets
charts, in worksheets  249

aspect ratios  256
axis titles  258
chart area  254
chart types, changing  257
color scheme, changing  259
combination  252
creating  251, 254
data, changing  257
data labels  258
data tables  259
deleting  257
display, configuring  259
editing  257
elements  258, 260
formatting  258–260
gridlines  258
layouts  250
legends  258
moving  256
order of data  255, 257
plot area  254, 259
plotting/replotting  251, 253, 255, 257
positioning  256
previewing data  251
resizing  256
selecting  255, 256
source data  254
structure, changing  254–257
styles  258, 259
supporting data, displaying  197
swapping data over axes  257
trendlines  259
types  250, 253

clearing cells  205, 207
clearing vs. deleting  207
clicking  xiv
Clipboard  100
closing

apps  44
files  43
search pane  72
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cloud storage  See Dropbox; iCloud; OneDrive; 
online storage

coauthoring  179
notebook content  381
workbook content  266

color schemes
slides  282
in tables  131

color-coding
See also cell references
cell selectors  238
function arguments  230

colors
animation effects  309
cell backgrounds  216
custom  216
reviewers, assigning  179
shape outlines  149, 150
shapes, changing  150
text boxes, applying  167
user accounts, and  180

column breaks  160–163
column charts  250
column margins

displaying  160
modifying  161

columns, in document text  See text columns
columns, in notebook tables

adding  352
removing  353

columns, in tables
displaying markers  130
inserting  132, 133
removing  133
width  130, 133

columns, in worksheets
adding  233, 234
copying  208
deleting  209
fitting to content  206
freezing  218
hiding  210
inserting  207, 235
measurements, displaying  206
moving  208
referencing  231

removing  235
resizing  206
selecting  201
sorting by  220
widening  212

commands
Backstage view  63
File menu  64–67
Print  73
ribbon and  62, 63
tables  130

comments
attaching to text  184
container handles, in workbooks  268
deleting, in documents  185
deleting, in workbooks  268
displaying, in presentations  298
displaying, in workbooks  268
hidden, in workbooks  267
hiding, in workbooks  268
icons  298
inserting  184
managing  184
navigating through  180, 185, 267, 298
responding to  184
reviewing  184, 267, 298
on slides  298
specific reviewers, hiding/showing  185
specific types, hiding/showing  181

community forums  42
conditional formatting  213
consecutive numbering  126
contacting Microsoft Press  xvi
content containers in slide layouts  290
content, restricting  15
copies

printing  65, 73
saving  59

copying text  100, 103
COUNT AutoSum function  244
Count function, in Total rows  229
Count Numbers function, in Total rows  229
cover pages

footers, and  172
page headers, and  172
page numbers, and  174
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creation date of files, displaying  66
credentials

See also accounts; passwords
deleting  16
Microsoft account, creating  10
Office 365 association  13

crop handles  139
cropping

aspect ratio  139
crop handles  139
images  139, 141, 142
photos, in Office Lens  356

Currency number format (Excel)  215
cursor

magnifying position of  98
positioning  98
positioning on slides  293

custom templates  50
cutting text  100

D
data, in worksheets

filtering  219–221
searching  59–62
sorting  219–221

data labels  258, 259
data ranges

See also cell ranges
converting tables to  235
filtering  220, 221, 231
formatting as tables  232
plotting as charts  253
searching  219
Sort & Filter buttons, displaying  220

data series
charts, and  251
color-coding  258
color scheme, changing  259

data sources, refreshing PivotTable  266
data tables  259
Date number format (Excel)  215
decimals, displaying  215
deleting apps  30
deletions, tracked  181
delivering slide shows  325, 330–333
demoting list items  128

descending order  220
design templates, PowerPoint  280, 283
desktop computer, synchronizing with 

OneDrive  40
desktop document templates  90, 92
desktop programs, Office 365 licensing and  11
dictating text

commands  96, 97
in documents  95–97, 99
marking errors  95
in notebooks  349

dictionary, adding words  294
digital images  See pictures
dimmed thumbnails  287
displaying

currently open apps  44
on-screen keyboard  67
properties of the current file  65, 66

distributing files  74–77, 381
document footers  See page headers and 

footers
Document Gallery  92
document headers  See page headers and 

footers
documents

See also files; templates
changes  178–183
comments  180, 183
creating  50–52, 90–93
elements of  121
moving content between  101, 103
opening  89, 91
printing  72–74
readability of  121
saving  91
searching  69–72
sections  176
templates  50–52, 90–93
tracking changes  178–183

double-sided pages, headers and footers  172
double-sided printing  72
downloads, of apps  20
dragging

charts in worksheets  256
indent markers  108, 109
text  100
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drawing canvas  148
drawing shapes  148
Dropbox

connecting to  38, 39
inserting files  358
remote file storage location  357

duplicate files, saving  59, 65
duplicating practice files  xii

E
Edit mode  200

on-screen keyboard  200
switching to  204
worksheets  243

editing
cell contents, in worksheets  204
coauthoring  179
files, online  59

effects, applying to pictures  142
email accounts  10
email messages

attaching files  75
opening attachments  57
sending file links  74, 77
sending PDFs  75, 381
sending to notebooks  359

Emoji keyboard  17, 93
emoticons

inserting into documents  93
settings  17

emphasis animation effects  306
empty tables, creating  132
ending points, moving in columns  162, 163
entering information  xv
entrance animation effects  305, 307
equation shapes  146
equations  See calculations; formulas
errata, submitting  xvi
error bars  259
errors, submitting  xvi
Excel desktop version features  193
Excel for iPad

features  192
modes  200
premium features  192
selection handles  200

Excel Online
accessing  195
features  192
workbooks, creating  195

exercise steps, general instructions  xiv
exit animation effects  306, 307
exiting files and apps  43, 44
expanding content to fit paper  74
external keyboards  60, 63

See also keyboards
shortcuts  390–392

F
features, premium  29
feedback, submitting  xvi
fields

adding to PivotTables  262
displaying in PivotTables  265
referencing in formulas  231
selecting in PivotTables  265

file links  74
creating  77
sending in email  75
sharing  77

File menu  64
file properties  66
files

See also documents; notebooks; 
presentations; workbooks

AutoSave and  58
changes, managing  65
closing  43
creating  50–52
deleting  51, 52
distributing  74–77
duplicate copies, saving  xii, 59, 65
editing online  59
emailing  75
inserting in notebooks  357–359
leaving  43
managing  64–67
moving  65
naming  58, 64
opening  34, 52–57
opening attachments  57
pinning  55
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properties  65–67
recently used  54, 55
restoring  65–67
saving  58, 64
searching  69–72
switching among  54
templates and  50

filling a data series  202, 205
fills

shapes  149, 150
text boxes  167
worksheet cells  213, 216

filtering
clearing filters  221
by column entry  221
data  219–221
data ranges  219, 220
PivotTables  262
tables  231

find and replace  70–72
finding apps

App Store  8
Office website  7, 9

first column  130
first line indents  108
first page

different  172
headers and footers, unique  174
page numbers, removing from  175

fitting columns to content  206
flowchart shapes  146, 302
folders

on the Home Screen  30
in remote storage locations  51

fonts  112
changing  115
copying/pasting  56
default Office fonts  283
substituting  56
theme fonts  102

footnotes  168, 169
formatting

See also text
changes, displaying in page margins  181
copying  116
numbers in workbooks  214–216

paragraphs  104–109
pasted text  102
pictures  139–145
removing from text  116
shapes  147–150
symbols, displaying  161
tables  134
text  112–116
text as bulleted list  123
worksheet cells  215, 216

Formula Bar
activating  230
formulas, entering  242
function list  247
functions, entering  248
hiding  199
opening  238
redisplaying  200

formulas  236
See also calculations; cell references; 

functions
arguments, defined  246
AutoSum  244, 245
completing  243
copying  231, 244
creating  236, 242, 243
editing  245
Formula Bar, entering into  242
function keyboard, using  238
numbers, entering  241
operands  237
operators  237
special symbols  241
syntax  239
updating automatically  231
validating  239

forums  42
forward slash (/), in Excel formulas  237
Fractions number format (Excel)  215
free

apps  4
email accounts  10
file storage  37
trial version of Office 365  13

freezing columns and rows  217, 218
function arguments, color-coding  230
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Function button  389
function on-screen keyboard  238, 389

displaying  204, 241
illustrated  239
multifunction keys  238, 241
switching to standard keyboard  238

functions
See also arguments; formulas; parameters; 

values
AutoSum  244
building formulas for  236
categories  247
definitions, displaying  247
descriptions of, displaying  242
entering  241
Formula Bar, entering in  248
list, in Formula Bar  247
nested  248
syntax of  247

G
General number format (Excel)  214
gestures  387

magnification level, changing  61
multitasking  45

graphs  See charts, in worksheets
gridlines

in charts  258
hiding  200
in worksheets  199, 200

grouping shapes  148

H
handles

cropping  139
pictures  140

hanging indents  108, 109
hardware requirements  4
hardware support  xvi
header row  130
headers  See page headers and footers
headings

repeating in tables  136
in worksheets  199, 200

height of rows, controlling  134
help resources  41, 42
help with hardware and software  xvi

hidden
characters  110
columns/rows  210
keys  205
paragraph marks  104

hiding
notebook content  378
slides  287

hierarchical structure of lists  125
highlighting slides  331
highlighting text  100
history

app versions  20, 21
file versions  67

Home Screen
deleting apps from  22
starting apps from  50

Home tab  62
how-to instructions  xiv
hyperlinks

creating  169
editing on slides  293
to external content  168

I
iCloud  15

files, inserting from  358
online storage  35
Photo Stream  138
searching  357
supported storage location  357

icon labels, changing  358
icons  xv

activating on the Home screen  22
as button labels  xv
vs. buttons  xv
deactivating on Home screen  22
inserting into documents  93
Install  9, 23
Settings  6
for specific apps  8
Updates  20

images
See also pictures; shapes
animation effects, applying  305–309
capturing with OneNote  356
overlapping  153
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in slide layouts  282
text wrapping options  152
wrapping text around  151, 152, 153

indenting
columns  160
first line indent  107
hanging indents  108
indent markers  107–109
left indent  107
paragraphs  104, 107–109
right indent  107
tables  130

information bar, system data  60
information, entering  xv
Insert tab  62
installing apps

App Store, from  9
automatically  15
Office for Mobile Devices website, from  7, 8
Office website, from  9
updates  18, 20

instructions, adapting  xiv
interface  See user interface elements
iOS

identifying, using iTunes  6
required versions  4
version, displaying  6

iPad Air  99
iPad device

backing up  5
configuring settings  15
orientation  xv

iPad settings  15
italics, applying  115
iTunes  5

J
justifying paragraphs  105

K
Keep Source Formatting  102
Keep Text Only  102
keyboards

See also external keyboards; on-screen 
keyboards

Bluetooth, connecting  83, 390
Emoji  17, 93

for entering characters  xv, 98
function keyboard  204, 238, 389
installing additional  17
languages, additional  17
multifunction keys  238
number keyboard  389
shortcuts  390–392
standard keyboard  238, 242, 388
switching between  17, 99, 238, 242
symbol keyboard  241, 389

L
landscape orientation  170, 176
languages

different keyboards for  17
supported by Siri  95

last column  130
layout  See page layout
layout of PivotTables, changing  266
layout options, workbooks  65, 72–74
legends, in charts  258
licensing

Office 365 portal, checking for  13
Office 365 subscriptions, and  11

line breaks
hidden characters  110
inserting, in documents  111
inserting, in worksheets  204, 205

line charts  250
line shapes  146
line spacing  106, 107
links

sending  75, 76
sharing  77
to notebooks  381

lists  122
bulleted, in documents  122–124
consecutive numbering  126
demoting items  128
multilevel  127
numbered, in documents  125
ordered  125
ordered and unordered, together in lists  128
promoting items  128
unordered  122

local storage space requirements  4
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locating apps  See finding apps
location of a file, displaying  66
locked files, options for working in  266
locking notebook sections  380
Lync  3

M
macro-enabled files, saving as  58
magnification level, changing  61
magnifying

cursor position  98
page content in notebooks  372
text in text boxes  293
using touch  373

Mail app
attachments, opening  57
sending file links using  74–76

manual calculation mode  249
manually installing updates  20
margins  See column margins; page margins
markers

on rulers  161
zoom  373

marks in columns, displaying  161
markup

types of  181
viewing  180

Match Destination Formatting  102
mathematical formulas

building from functions  236
in tables  131

mathematical operators  237
MAX AutoSum function  244
Max function, in Total rows  229
media  See audio recordings; video recordings
merging cells  212–213
messages  See email messages
microphones

controlling use of  15
iPad Air  99
location on devices  99
shortcut key  94

Microsoft accounts
associated online storage  27
creating  10, 11
Office 365 associating with  13

registering existing email addresses  10
standard features  28

Microsoft Answer Desk  42
Microsoft Community forum  42
Microsoft Press contact information  xvi
Microsoft Press Store  xvi
MIN AutoSum function  244
Min function, in Total rows  229
minus sign (-), in Excel formulas  237
mirrored margin setting  171
mistakes, submitting  xvi
mixed references  240, 243
movies  See video recordings
moving

files  65
text  100, 103

multicolumn tables, creating  131
multifunction keys  238
multilevel lists  127–129
multitasking gestures  45

N
names of folders, changing  30
naming files  58
navigating among apps  45
nested functions  248
new account, creating  10
new files, creating  50, 52
new line characters  293
new page section breaks  177
next page section breaks  177
note containers  351
notebook notes

See also notebook pages
inserting files  357
linking to files  359
organizing in tables  352
storing information  359

notebook pages
See also notebook notes; notebook sections
background colors  360, 361
creating  349
deleting  364
demoting/promoting  349
moving  360–362
naming/renaming  349
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note containers  351
page navigator  360
restoring deleted  364
selecting  361
subpages, changing to  349

notebook sections
See also notebook pages; notebooks
creating  348
deleting  364
displaying  361
editing  364
grouping  348
locking/unlocking  380
moving  360, 362, 363
moving pages  361
naming  348
passwords  380
protecting  378–380
renaming  348

notebooks  342
See also files; notebook sections
adding information  349–359
closing  346
creating  342
Full Page view  371, 372
opening  343, 344
printing  381
protecting sections  378–380
reopening  346, 347
restoring  352
saving  352
searching  376–378
sections  347, 348, 360–365, 378–380
sending links and PDFs  381
sharing  342
sharing content  381
source location of  343
storage options  342
structure, configuring  347–349
switching between  345
switching views  371
synchronizing  343
synchronizing content  382
tags, inserting/removing  375
tasks, linking to Outlook  359
user interface elements  347
views  370, 371, 373

notes, in notebooks  See notebook notes
notes, in presentations  See slide notes
Notes pane (PowerPoint)

displaying  316–318
hiding  319

Number format (Excel)  215
number formats (Excel)

categories  214
specifying  216

Number key  389
number on-screen keyboard  241, 389
numbered lists  125

consecutive numbering  126
creating  125, 126
demoting items  128
mixing with bulleted lists  128
multilevel  127
numbering style, changing  126
paragraphs, formatting as  126
promoting items  128, 129

numbering  See numbered lists
numbers

displaying  212
entering  241, 389
shortcut keys  94

numeric data, formatting  214
numeric values

displaying statistics  246
sums  229

O
Office 365

activating  27, 32
associated online storage  27
benefits of  53
features activated by  4, 32
free trial  14
licensing  11, 13, 59
Microsoft account, associating with  10
premium features  28
restoring subscriptions  33
signing in  31
subscriptions  11–14

Office apps
closing  43, 44
configuring settings  16, 17
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Office apps (continued)
deleting  22
Help resources  41, 42
installing  7–9
reinstalling  22, 23
ribbon tabs  62
settings, displaying  16
starting  29
updating  18
user interface  59–67

Office for iPad apps, support  xvi
Office Lens  354–357
Office Online apps  59, 86, 192, 278, 340
Office website, installing apps from  7–9
OneDrive  36, 37

accessing  27, 37
accessing files  53
account  38
browsing content  34
coauthoring document content  179
connecting to  38, 40
documents, saving to  89, 91
files, opening  34, 56
personal vs. organizational  36
storage location, adding  38
storing practice files  xii
synchronizing with computers  40
types  36

OneDrive for Business  See OneDrive
OneNote for iPad

benefits  339, 369, 378
features  340
Office 365 Personal subscription and  12
Office Lens  354–357
photos, capturing  354
premium features  28
Quick Notes  343
supported storage locations  357
user interface elements  347
views  370, 371

OneNote for Windows
features  341
notebooks, deleting  361
note containers  351
section groups, deleting  361
storing information  359

OneNote Online, features  340

online storage
accessing  27
connecting to  35–39
managing providers  359

online support  42
online templates  89–91, 194
on-screen keyboard

See also keyboards
#+= key  389
.?123 key  389
123 button (Excel status bar)  389
Abc button  390
displaying  67
displaying symbols  390
emoticons  93
function keyboard  238, 389, 390
hidden  60
hidden keys  205
hiding  67, 390
icons  93
installing additional  17
languages, additional  17
multifunction keys  238
number keyboard  241, 389
rejoining  68, 390
shortcuts  388–390
splitting  68, 390
standard  388
switching between  17
switching to standard keyboard  390
symbol keyboard  241, 389
tips  388–390

opening files  34, 52–57
operands, defined  236
operating system  See iOS
operations, order of processing  237
operators, mathematical  236
ordered lists  125, 128
organizing apps in folders  30
organizing information in tables  129–136
orientation of the iPad  xv
outdenting paragraphs  108, 109
outline colors

shapes  149, 150
text boxes, applying to  167

outlines
shapes, and  147, 150
text boxes, removing from  168
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Outlook, linking tasks to notebooks  359
Outlook Web App  3
overlapping images  153

P
page breaks

managing  176, 177
by section breaks  177
soft  176

page headers and footers  172
adding  172–175
content, removing  175
cover pages, and  172
double-sided pages and  172
editing  174
first page, unique  174
formatting  173
hiding  200
odd and even pages  175
options  173
page numbers, displaying in  174

page layout  170
commands  170
sections  176

page margins  170, 171
displaying changes in  181
mirrored  171
options  171
sections, and  176
setting  172

page navigator  360
page numbers

on cover pages  174
on first page  175
formatting  175
in headers and footers  175
moving  175
removing  176

page orientation
options  170
setting  172
when printing  74

page ranges, printing  72, 73
page sizes, in Word

margin options  170, 171
setting  172
supported  171

pages, in notebooks  See notebook pages
pane colors  60
panes

freezing  217–219
frozen, identifying  217
unfreezing  219

paper size
changing  74
standards  171

paragraph formatting, on slides  318, 319
paragraph marks

described  104
hiding/showing  110

paragraphs
alignment, configuring  105
anchor association  137
bulleted lists, formatting as  123
formatting  104–109
hanging indents  109
hidden characters  104, 110
indenting  104, 107–109
line breaks, inserting  110
numbered lists, formatting as  126
outdenting  108, 109
pictures, inserting  137
positioning text manually  110, 111
ragged edge  109
resetting to Normal style  104, 105
soft returns  110
spacing  106, 107
styles  113
tab stops  110, 111
tagging in notebooks  374
wrapping lines  110

parameters
See also arguments; search parameters; 

values
definition  246
required and optional  246, 248
types  247

passcode, requiring  15
passwords

for Microsoft accounts  10, 15
for notebook sections  379

paste options  102
pasting text  100, 102
patterns, filling cells with  205
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PDF files
sending in documents as  75
sending notebook pages as  381

pending updates, installing  20
Percentage number format (Excel)  215
permissions for sharing file attachments  77
personal Office 365 subscription  12
perspective shadows  143
Photo Stream  138

inserting photos in documents  136, 137, 140
inserting photos in notebooks  353–356
inserting photos in presentations  299, 300

photos  See pictures
Photos & Camera, configuring settings  15
picture commands  138
picture styles  142–143
pictures

See also images
aspect ratio  139, 141, 142
capturing from OneNote  356
cropping  139, 141, 142
cropping with Office Lens  356
effects, applying  142–144
enhancing with Office Lens  354–356
handles  140
inserting  136–138, 140, 299–300, 353–356
moving  152, 300
reflections  144
replacing  145
resetting  145, 300
resizing  139, 140, 141
Rotate handle  140
rotating  139, 142
selecting  141, 300, 356
settings  15
shadow effects  142, 144
storage locations, configuring  15
styles  142–143
uploading automatically  138

pie charts  250
pinning files  55, 346
Pivot Filters  262
PivotTables  260, 261

See also tables (Word)
aspects of  264
data source, and  266
displaying details  265
fields, adding  262

fields, displaying  265
filtering  262
layout, changing  266
structuring  262, 264
styles  264

Places  35
adding  39
OneDrive storage and  38

playback controls
audio, on slides  326
video, on slides  326, 329

playing audio on slides  329
playing videos on slides  325, 329
plot area  254, 259
plotting charts  251, 253, 255
plus sign (+), in Excel formulas  237
populating a table, defined  228
portrait orientation  170, 176
positioning text manually  110, 111
PowerPoint desktop versions

comments  298
content containers  290
features  278, 279
slide masters, editing  282

PowerPoint for iPad
features  276, 277
premium features  277

PowerPoint Online features  278
PowerPoint templates  280–285
practice files  xii
preformatted styles

document templates, in  113
text, adding to  116

premium app features  4, 12
activating  13, 32, 33
Excel for iPad  192
OneNote for iPad  28
PowerPoint for iPad  277
trying out  13
unlocking  4, 11
Word for iPad  85

presentations  275
See also files; slide shows; slides; video 

recordings
adding slides  287, 288
comments  298
creating  50–52, 280–285
delivering  325, 330–333
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fonts  283
moving slides among  288
notes  316–319
panes  317, 318
presenting  325, 330–333
printing  72, 73
slide transitions  315, 319–322

presenter notes  See slide notes
presenter tools  331
Presenter view, slide shows  330–333
preset fills

for shapes  149
text boxes, applying to  167

preset table formatting  134
preview window, editing files from  359
previewing files, from embedded icons  358
previous file versions, restoring  66
print options  65, 72, 73
printing  72–74

AirPrint printers  72, 73
documents  73
notebook content  381
Office files to notebooks  359
options  65, 72, 73
PowerPoint for iPad, limitations  316
presentations  73
scaling to fit paper  74
wireless networks  72
workbooks  74

procedures  xiv
prohibition sign on slide thumbnails  287
promoting list items  128, 129
properties, displaying for files  65
pull quotes  164
punctuation, dictation commands for  96
purchased apps

automatically installing  15
reinstalling deleted  22, 23
version history  20

Q
Quick Notes  343

R
radar charts  250
ragged edges of paragraphs  109
ranges  See cell ranges; data ranges

read-only
file links  74, 77
files  53

Ready mode  200
and worksheets  243
switching to  204

recently used files  54, 55
rectangle shapes  146
Recycle Bin  364
redoing changes  63
referencing cells  207, 240, 242
referencing column names, in formulas  236
referencing data, in formulas  231, 236
referencing fields, in formulas  231
referencing information

in footnotes  168, 169
using hyperlinks  168, 169

referencing tables, in formulas  231
reflection effect

displaying  144
removing  144
variations  143, 144

refreshing display of folder contents  51
rehearsing slide shows  331
reinstalling apps  22, 23
rejoining on-screen keyboard halves  68
relative references  240, 241
remote file storage locations  4
remote storage  See storage locations
removing apps

from folders  30
from the iPad  22

removing character formatting  116
renaming folders  30
repeating changes  63
replacing

content  70–72
pictures  145

Report Filters  263
repositioning apps on Home screen  22
requirements, hardware  4, 6
resetting

apps  16
paragraphs to Normal style  105
pictures  145

resizing
charts, in worksheets  256
columns  206
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resizing (continued)
pictures  139, 141
shapes  149

responding to comments  184
restoring

deleted content  133
deleted notebook pages  364
files  65–67
iPad to original state  4
notebooks  352

restricting
access to app and website content  15
search results  69, 71

reusing text  100
reverting

changes  65
deleted content  133

Review tab  62
reviewers

See also tracked changes
colors assigned to  179
comments, showing/hiding  185
markup, hiding/showing  181

reviewing
comments in documents  184, 185
comments in presentations  298
comments in workbooks  267, 268
documents  178–185
tracked changes  178–182

revisions  See documents; tracked changes
ribbon  60, 62

buttons  63
character formatting commands  112
picture commands  138
table commands  130
tabs  62
text effects  112

rolling back  65
rotating

pictures  139, 142
shapes  149
text in text boxes  168

rows, in document tables
height, controlling  134
inserting in tables  132
mathematical formulas  131
removing  133

rows, in notebook tables
adding  352
removing  353

rows, in worksheets
copying  209
deleting  209
fitting to content  206
freezing  218
height, changing  207
hiding  210
inserting  208
measurements, displaying  206
moving  209
referencing, in formulas  231
selecting  201

rows, in worksheet tables
adding  233, 234
removing  235

ruler
column indents and margins  160
column markers in tables, displaying  130
column widths in tables, displaying  130
displaying  104, 108, 161
indent markers  107

running apps, switching among  45
runover text, in worksheets  212

S
saving

automatically  58, 64, 66
duplicate files  xii, 59, 65
files  58, 64, 66

scaling content to fit paper  74
scatter charts  250
scientific notations, displaying in 

worksheets  212
Scientific number format (Excel)  215
screen locking  15
search pane, closing  72
search parameters  377  See also parameters
search results

moving among  71
notebook content  376, 377
restricting  71

search terms, replacing  71
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animating on slides  308
formatting  149, 150
inserting in documents  146–148
inserting in presentations  301–303
outlines  151
resizing  149
rotating  149

shared notebooks
location  381
synchronizing  382

SharePoint sites
coauthoring document content  179
connecting to  38, 39
navigating storage structure  35

sharing
files  74–77
notebook content  381

sheet tabs  196, 200
sheets  See worksheets
shortcut bar

columns/rows, selecting  201
displaying/hiding  203
section tabs  364
text, selecting  101

shortcuts  63, 94
showing

comments  185
hidden characters  110

shrinking content to fit paper  74
signing in to Office apps  31–33
Siri  95
size of files, displaying  66
sizing

pictures  139, 141
shapes  149

sizing handles
charts  256
pictures  138
shapes  149

Skype for Business  3
slide layouts

See also slide masters; slides
built-in  286
designating  288
design templates  285
elements, defined by  285

searching
file content  69–72
iCloud  357
notebook content  376–378
whole words, for  71
workbook data  219

section breaks  176
See also text columns
to create text columns  161
deleting  163
inserting  177
types  177

section groups  348
section tabs, editing  364
sections, in notebooks  See notebook sections
selecting

cells, columns, and rows  201
chart data  253, 257
shapes  149
text  100, 101
worksheets  201

selection handles
displaying in documents  101
displaying in worksheet cells  200
selecting cell ranges  243, 245
selecting chart data  253, 257
selecting columns and rows  208–210

sending
content to OneNote  359
file links  74, 75, 381
PDFs  75, 381

settings
backup  5
configuring  15
displaying  16

shading
cells, applying to  135
plotted chart data  256
in tables  130

shadow effect
adding  144
removing  144
variations  142

shapes
See also images
adding text  304
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slide thumbnails, dimmed  287
slide transitions  315

See also slides
animating  304, 319–322
applying  322
backgrounds  304
best practices  322
configuring options  322
effects  320, 321
identifying  321
Random Transition option  321
removing  322
shooting star icon  321
three-dimensional  320

slider background, changing  161
sliders  71
slides

See also slide layouts; slide notes; slide 
transitions; text boxes; video recordings

adding  287, 288
animation effects  304–310
annotating  331
aspect ratios  280
color schemes  282
comments  298
copying  288
creating  285–289
current, identifying  317
deleting  287
designating layouts  288
designs  286
displaying  288
editing  287, 293
formatting  291
hiding  287
marking up  331
masters  282
moving  287, 288
selecting  288
sizes  280, 281, 285
Smart Guides  290
themes  282, 283

Smart Guides  290
soft page breaks  176
soft returns  110
software  See apps
software support  xvi

slide layouts (continued)
images  282
modifying  290
predefined  283
reapplying  290
scaling  282
slide designs  286
standard  281
structure  285, 286
themes  283
widescreen  280, 282

slide masters, editing  282  See also slide layouts
slide notes  315

See also slides
adding  316–318
creating  316–319
default font  317
displaying  284, 318
displaying to presenter  330, 333
formatting  317
hiding  319
locating  317
printing  316

Slide pane (PowerPoint)  284, 285, 287
slide shows

See also presentations; slides
delivery methods  330
ending  333
hidden slides  287
moving among slides  332
pausing  332
playing audio and video recordings  329
presenter tools  331, 332
Presenter view  330–333
presenting  325
rehearsing  331
restarting  332
skipping slides  332, 333
speaker notes  333
Standard view  330
starting  325, 332

slide sizes
aspect ratios  280
changing  281, 285
selecting  281
standard  281
widescreen  280
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Photo Stream  138
Places  35
remote  4
SharePoint  38, 39

storage space
app requirements  4
freeing up  4
usage, displaying  6

storage structure, files  53
striking through text  115
styles

charts  258
copying  114
documents, finding in  114
modifying  114
pictures, applying to  142, 143
PivotTables  264
preformatted  113, 116
removing from tables  135
in tables, applying  135
tables, in worksheets  229

stylus  xiv
submitting errors  xvi
submitting feedback  xvi
suboperations  237
subpages, in notebooks  349
subscript character format  115
subscriptions, Office 365

benefits of  53
features available with and without  29
options  11

substituting fonts  56
SUM function  244
Sum function, in Total rows  230
superscript character formats  115
support resources

hardware and software  xvi
Microsoft Press Support  xvi
Office for iPad apps  41, 42

surface charts  250
switching

between keyboards  17, 238, 242
files, among  54
between open notebooks  345
running apps, among  45

symbol on-screen keyboard  241, 389
Symbol key  389

Sort & Filter button, status labels  220
sorting worksheet data

by column  220
data, in worksheets  219–221
data ranges  219, 220
sort order  220

spacing
between document elements  110
columns, between  163
paragraphs  106, 107
vertical, in paragraphs  106

speaker notes  See slide notes
speaking, to enter information  xv
special characters, entering  389
Special number format (Excel)  215
spellcheck  99
spelling

error indicators  294
errors, correcting on slides  295
suggested corrections  294
tools for checking  99

splitting the on-screen keyboard  68
spreadsheets  See workbooks; worksheets
stacking images  152
stacking order  152
standard keyboard  242
standard on-screen keyboard  388
standard slide layout  281
Standard view (slide shows)  332
star shapes  146
starting apps  29, 31
starting points in columns, moving  162, 163
statistics

on status bar  246
in Total rows  233

status bar, location  60
StdDev function, in Total rows  230
stock charts  250
storage locations

adding  38
Clipboard  100
configuring for photos  15
connecting to  35–39
default  35
displaying  34
iCloud Drive  15
OneDrive  3, 36–40, 53, 56, 57, 59
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management tools  231
pasting into worksheets  202
plotting as charts  253
referencing, in formulas  231
resizing  235
rows, inserting/deleting  235
selecting  232
shading  229
style options, specifying  233
styles  229, 233
Total rows  229

tables (OneNote)  352
columns  352
deleting  353
inserting blank  352
rows  352

tables (PowerPoint)  296, 297
copying from other Office files  296
documents, inserting from  297
inserting  297

tables (Word)  129–136
banding columns and rows  130
borders  130
cells  129
color schemes  131
column markers  130
column widths  130, 133
columns, deleting  133
columns, inserting  132
copying to presentations  296
deleting  136
elements, formatting  135
empty, creating  132
features, emphasizing  130
first column  130
formatting  130
header row  130
headings, repeating  136
last column  130
multicolumn, creating  131, 132
row height  134
rows, deleting  133
rows, inserting  132
selecting  132
selector  130
shading  130, 135
sizing handle  130

symbols
bullets, changing  124
dictation commands for  97
displaying on function keyboard  242
entering  241, 389, 390

synchronizing
iPad with iTunes  4, 5
notebook content  382, 383
OneDrive with computers  37, 40

syntax
formula references  239
of functions  247

system data, information bar  60

T
tab characters

aligning  111
aligning text with  110
hidden characters, as  110
inserting in tables  131
inserting in text  111, 293

tab stops  110, 111
table elements

emphasizing  229
formatting  135
functional, in worksheets  229

table selector  232
in document  130
in worksheets  232

table sizing handle  130
tables (Excel)  228

banded columns  229
banded rows  229
columns, inserting/deleting  235
converting to data ranges  232, 235
copying to presentations  296
creating  228, 232
elements, emphasizing  229
extending  233, 234
filling  234
filtering  231
first row  229
functionality, removing  232
header row  229
hiding columns/rows  210
last column  229
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reverting to regular text  163
spacing  163
width  162

text containers  See text boxes
text direction, changing  168
Text number format (Excel)  214
text to table  131
text wrapping

images, and  151
options, with images  152

theme colors
text boxes, filling  167

theme fonts  102
themes

paste option  102
slides  282, 283
in tables  131

thumbnails  See slide thumbnails
Thumbnails pane (PowerPoint)  284, 285, 287
Time number format (Excel)  215
toggling keyboards  238
tool tabs  62  See also ribbon
Total rows, in Excel tables

default display  229
functions  229, 230
options  229

Total rows, in Word tables  130
touchscreen gestures  387
tracked changes  178

See also reviewers
accepting/rejecting  182
colors  180
display options  180
displaying  178, 181
navigating  180
reviewing  181
specific types  181
turning on/off  183

transition effects, in presentations  See slide 
transitions

transparency, applying to shapes  150
trendlines  259
trial version of Office 365  14
troubleshooting  41, 42
truncated numbers  212
Twitter address for Microsoft Press  xvi

styles  135
text, formatting  131, 134
themes  131
Total rows  130, 131

tabs  See ribbon; section tabs; sheet tabs; tab 
characters; tab stops

tagging notes  374–375
tapping  xiv
technical support  42
templates

creating files from  50
Excel  194, 195
PowerPoint  280, 281
preformatted styles  113
previewing  89
saving files as  58
styles  114
Word  90, 92

text
See also formatting; text boxes; text columns
arranging with images  151
comments, attaching to  184
copying to Clipboard  100, 103
cutting to Clipboard  100
deleting  103
dictating  95, 99
document text, inserting on slide  294
entering  93, 98, 294
fonts  56, 112, 115
keyboard shortcuts  94
moving  100, 101, 103, 296
pasting  100, 102
preformatted styles, adding to  116
rotating in text boxes  168
selecting  101, 295
on slides  292–296
spelling errors, correcting  295

text boxes
See also slides; text
in documents  164–168
on slides  290–292

text columns
See also section breaks; text
adding or removing content  162, 163
margins and indents  160, 161
number of  162
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inserting on slides  323, 326
managing playback  325, 326, 329
previewing on slides  328
searching in notebooks  376

volume control in presentations  325

W
webpages, hyperlinks to  169
websites, linking from notebooks  350
whole words, searching for  71
widescreen slide layout  280
width

columns, changing in Excel  206
columns, changing in Word  162

Wi-Fi
computer, syncing with  5
configuring  15

windows  60
Windows computers

desktop versions of Office for  13
Office 365 subscriptions  11

wireless networks, printing  72, 73
Word 2011/Word 2013 templates

creating documents from  92
finding  90

Word desktop versions, features  86, 87
Word for iPad

compared to Word Online  86
documents, opening  89
features  84, 85
premium features  85

Word Online
compared to Word for iPad  86
documents  89, 91
editing with  85
features  86
templates  89

WordArt effects  164
adding  115
applying to text boxes  165
in documents  113

workbooks
See also files; worksheets
blank, creating  50, 195
collaborating  266–268
comment container handles  268
comments  267, 268

U
underline, applying  115
Undo

deleted content  133
worksheets, and  197

undoing changes  63, 65, 66
unfreezing panes  219
unhiding

columns/rows, in worksheets  210
notes, in presentations  319
presenter notes  333
speaker notes  333
user elements, in worksheets  200
worksheets  198

universal no symbol  287
unlocking

notebook sections  378–380
premium app features  4, 11

unordered lists  122, 128
unsaved files  52
unwrapping content in cells  213
up/down bars  259
updates

App Store, installing from  18
downloads, displaying list of  20
installing  20

Use Destination Theme  102
user accounts, revision colors  180
user experience, optimizing  15
user interface elements  59–67

cosmetic vs. functional  49
Excel, hiding/unhiding  200
OneNote  347

V
validating formulas  239
values  See arguments; numeric values; 

parameters; statistical values
Var function, in Total rows  230
version history

for apps, displaying  20, 21
for files, displaying  67

versions, restoring files  66
vertical spacing, configuring  106
video recordings

deleting from slides  327
formatting on slides  324–328
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Z
zoom  61

controls, turning on  61
manually changing  373
markers  373

Zoom Controller  61

creating  50–52, 194, 195
deleting worksheets  197
printing  74
print layout options  74, 74–76
searching  69–72, 219
templates  194, 195
tracked changes  267
worksheet tabs  199

worksheets  191, 196
See also workbooks
adding  196
deleting  197
elements of  199
freezing columns and rows  217–219
gridlines  199, 200
headings  200
hiding  198
hiding elements  200
moving within workbook  198
organizing data  196
printed page display  206
printing  72, 74
renaming  197
reordering  198
reversing actions  197
searching content  69–72
selecting  196, 201
size limitation  196
structure, changing  210
tabs  196, 199

wrapping cell contents in worksheets  202, 212, 
213

wrapping lines in paragraphs  110
wrapping text around images  152

X
X Y (scatter) charts  250

Y
Yammer  3
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